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Note 1: This Manual has been prepared for my own use. If you 

find it useful, great. However, don't be surprised (or angry 

with me) if I have failed to update something that has changed 

from one version of Poser to the next and which I haven't 

discovered yet. Or if I have failed to understand and so 

incorrectly describe something. If I discover (or have pointed 

out to me) that something in this Manual doesn't work as I 

described, I'll see about updating my text. 

 

Note 2: I installed Poser 12 on 30 November 2020. I have no idea 

if anything in this Manual has changed in Poser 12. I will make 

necessary changes as I find them. I installed Poser 13 on 28 

July 2023, but am not using it yet because it won’t handle 

Backgrounds properly and I’m waiting for an update to take care 

of that and whatever other bugs have been fixed. 

 

I began using Poser Pro 2012 on about 2013 01 07. This file was 

started soon after doing a bit of experimenting and finding that 

I had no tutorial. So here are the results from experimenting, 

reading Poser Pro 2012 Reference Manual, Poser Pro 2014 

Reference Manual, Poser Pro 11 Reference Manual, Smith Micro 

Tech Support, and internet research. I also have Practical Poser 

8. The Official Guide, by Richard Schrand, even though Poser 8 

would seem to be several iterations behind Poser Pro 2014, and 

even farther behind Poser Pro 11 which I started using in 

December 2015, or Poser 12 as noted above. 

 

I began using Poser 13.1 around the beginning of October 2023. 

 

Most of the information in this Manual is based on my 

experiences with Poser Pro 2012 and 2014, and probably still 

holds true for Poser Pro 11, Poser 12, Poser 13, or later 

versions. I'll note anything that seems to be unique to Poser 

Pro 11 or Poser 12. I'll revise parts of this manual as I find 

changes. 

 

Remember: This file is being created for my own use. Because I 

don't use Poser professionally, I don't use it often enough to 

become an expert in its use. So I tend to consider myself a bit 

of a "newbie," which means that either I am ignorant of some 

Poser function or I forget something between the times that I 

use it. If you find this Manual helpful, great, but don't expect 

it to be a full-blown tutorial. Some things may change as I 

discover the way that they should have been done in the first 

place, as opposed to the jury-rigged process that I came up 



with, so you may want to check back periodically for my latest 

update. 
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 Special Information 

 

Default Figure: When the program is loaded, the default figure 

is "Andy2," a mannequin with no apparent use. He can be removed 

via Figure > Delete Figure. See also, Launch to Preferred State, 

below. 

 

Document Window Size: If the Document Window mysteriously 

changes to a new size, go to the drop-down tab for Window > 

Document Window Size: set the preferred size, such as 1401 x 

788. 

 

Loading from a File: If you want to load a figure directly from 

a file instead of opening the figure from Poser, double click 

the PZ3 file, not the PMD file. 

 

Not responding: Sometimes when loading a figure or the program 

is doing some task, a "Not Responding" message can be seen at 

the top of the page. The program has not crashed (we can only 

hope). The programmers just didn't have the program say 

something helpful like "Busy. Wait a moment" instead. Just be 

patient and Poser will eventually begin “responding.” 

 

Rendered Image: When you Render an image, the last rendered 

image is shown before rendering begins, so it may look radically 

different than the current pose. Just ignore it. It is gradually 

replaced by the new rendered image. 

 

Saving the Current Scene: File > Save or File > Save As. Make 

sure you rename the file after significant changes. Do this 

frequently, in case you have problems later (my Poser Pro 2012 

tends to stop working frequently) and you find it easier just to 

go back to last Save. 

 

Saving a Rendered Image: File > Export > Image... instead of 

Save. The default file extension is PNG, but JPG or others can 

be selected. 

 

Selection Hazards: Always check to make sure that you have 

selected the proper/entire figure, prop, light, camera, etc. 

that you want to modify before you start. The same must be done 

if you want to save a modified figure to the library. And the 

same must be done if you want to modify things in the Materials 

room or you want to change Parameters/Properties. I often add a 

texture or pose from the Library and find that nothing happens. 

I tried to save a figure of my Tahiti character to the Library 

and only her hair was saved! The reason for both of these was 

that the Figure that I wanted to modify or save had not been 

selected. On the top left edge of the Preview window are two 



drop-down menus that allow you to select what it is that you 

want to modify and which name the items selected. The first of 

these names the Figure selected. The second names either the 

specific part of the selected Figure or a selected Prop (which 

may have nothing to do with the selected Figure.) Although the 

items selected are clearly named, it is very easy to ignore 

these. Mousing around the Preview window can change what is 

selected without your noticing it. Loading a saved file does not 

mean that the item selected is what you wanted it to be. If you 

just load a Figure and immediately load a Pose or Texture, you 

may be surprised at the results, which can range from an 

annoying search for files that don't exist, requests to create 

something that doesn't exist, some other strange result, or 

(apparently) nothing at all. This could be because you need to 

have the Body of the Figure selected, but loading results in the 

Hip being selected. Always check to make sure that you have 

selected the proper/entire figure, prop, light, camera, etc. 

that you want to modify before you start. The same must be done 

if you want to save a modified figure to the library. And the 

same must be done if you want to modify things in the Materials 

room or you want to change Parameters/Properties. Unnoticed 

changes in Selections is a real pain! 

 

Render Time: Rendering can take quite a while. An Alyson/Maria 

test took about 5 minutes 25 seconds with or without WordPerfect 

with this manual file and the Poser Library running. Without 

these programs and with only 1 light, the time was about 4 

minutes, 37 seconds. But some renders can take as long as 

several days! See Image Persistence for the danger in long 

renders. 

 

Color Values: Materials has 4 color value settings that can be 

changed so that hair, clothes, etc. can be changed. Clicking any 

of the color bars under Diffuse, Highlight, etc. will open a 

small window of colors. Click the tri-color box at the right to 

open a color-picker window so that color values can be set. 

Diffuse color, Ambient color, Highlights, and Reflections can be 

chosen from some combination of the colors and digital input 

boxes shown, or from the digital input boxes alone. 

 

Diffuse color is the primary surface color. 

 

Ambient color is the color emitted equally in all directions. It 

simulates the overall room lighting conditions.  I think one of 

the tutorial videos said this could be used to make the object 

glow. 

 

Highlights are bright areas where light is reflected directly at 

the camera. 



 

Reflections direct light back at its source. 

 



 

Poser Pro 11 

 

I upgraded to Poser Pro 11 in early December 2015. I would 

recommend that you not uninstall any earlier versions that 

you've been using until all the issues with the new release can 

be addressed. They've already released one update and it didn't 

fix the problems that I've seen. 

 

Older Versions: Before I mention some of the problems which I've 

found, I should say something about uninstalling earlier 

versions. Before I thought about the consequences, I uninstalled 

Poser Pro 2012. Then I realized that some of the Scene files 

that I've saved for future use contain Figures and Props from 

the Poser Pro 2012 Runtime. I was advised by Smith Micro Tech 

Support that these items are not part of the CR3 file that is 

saved. The CR3 file contains links to these items. I was of the 

opinion that uninstalling PP12 would delete these items from my 

hard drive. SM Tech Support suggested a couple ways to get 

around this, but I noticed that my hard drive's Program Files 

folder still has a Poser Pro 2012 folder in its Smith Micro 

folder, and this contains a Runtime folder which seems to 

contain the files that I was worried about. So it may be okay to 

uninstall previous versions. But, just in case, I don't think I 

will, even if Smith Micro fixes the problems which I've found. 

 

Library Folder Icons: In earlier versions of Poser Pro, Library 

Folder and Content Icons often were not loaded with the Library-

-just a placeholder which worked in its place. Switching to 

another Library folder and then switching back, often resulted 

in the missing icon being loaded--and some other icon's 

disappearance. Repeating this procedure often enough usually 

ended up with all icons loaded. Clicking the folder's Refresh 

button didn't seem to have much, if any, effect. This is not a 

critical problem unless you want to do a screen save of all the 

icons. Poser Pro 11 still had this problem with images 

associated with Folder icons (but not Content icons). Clicking 

the folder's refresh button usually loaded the missing images. 

The recent update (to version 11.0.1.31230) did not fix the 

problem. Now clicking a folder's refresh button may load the 

missing image, and make others vanish. Repeated clicking of the 

Refresh button (2 to 21 times) can result in everything in the 

folder disappearing and a failure of the Library to work at all 

until the Library's Reload button is clicked (bottom right of 

its window). 

 

Ground Prop: Not a bug, but Poser Pro 11's Ground Prop is 

different than for earlier versions--it has a ground plane and a 

background dome. Unless you uncheck its Visible Property, it can 



cause problems with large items like TerraDome 2. For more info, 

check here. 

 

Superfly Render Engine: Fortunately, Poser Pro 11 still allows 

you to render with Firefly. Superfly tends to make scenes appear 

as though the lights are much brighter, which can result in loss 

of shadow detail. I'm still waiting for a solution to this 

problem. 

 

DAZ Genesis/DSON Importer: Poser Pro 11 will not load more than 

one Genesis (or Genesis 2) Figure or Prop which requires DAZ's 

DSON Importer.  And once the DSON Importer has done its job, 

nothing else in the Library can be loaded. For more on this 

topic, go to Genesis in Poser Pro 11. 

 

Poser Pro 11 Stopped Working 

 

On about 24 September 2016, I began to get a green progress bar 

window saying "Poser Pro executable file has stopped working" 

and ending with a "Close Program" button every time that I tried 

to open Poser Pro 11. Poser Pro 2014 would still run. Nothing 

that I found by Googling the problem solved the problem. So I 

contacted Poser Technical Support and asked for help. John 

worked on the problem for a couple weeks - try this, try that, 

before he found that just having Lavasoft's Ad-Aware Web 

Companion installed on the computer (even if inactivated) might 

be associated with the problem. When I uninstalled this program, 

the problem went away! If you are having this problem, you might 

try this solution. 

 

I would also get this same window at random times with both PP11 

and PP2014 - sometimes at the start, sometimes in the middle of 

a project. However, I was always able to restart the program and 

hope that it didn't crash again too soon (sometimes it did, 

sometimes it didn't). I learned to do frequent Saves to avoid 

losing much work. Since I uninstalled Ad-Aware Web Companion 

just 2 days ago, I don't know if this has eliminated this random 

crash or not. But Poser hasn't crashed yet. (Knock on wood!) 

 

I've been using Poser Pro 2014 to recreate some images for my 

"Poser Contents" file. After 6 days with no problems, it crashed 

3 times with the same error message as before. But, as in the 

past, I was able to restart the program and keep working. I 

haven't used Poser Pro 11 much, so I still don't know how it's 

working. 

 



 Installing Content 

 

General Info: 

 

Smith Micro says to turn off Use External Binary Morphs in the 

General Preferences/Miscellaneous tab if DAZ figures are used. 

 

Creating New Library Folders: 

 

If a new Poser Library category is to be created (for instance, 

a category named Vehicles,) I create a target folder in C:\00-

Data\Poser Pro 2012\Libraries\Name. Create a subfolder: 00-

Data\Poser Pro 2012\Libraries\Name\Runtime. Open the Library and 

select Add Library at the top right. Find the new folder and 

select it. The new Library folder will be placed near the bottom 

of the list of folders. To put it where it “should be,” go to 

Alphabetizing the Libraries. 

 

Note: C:\00-Data is the folder where I store all the folders of 

files that I want to be able to find easily. Also note that I 

should have named the Poser Pro 2012 folder Poser Pro or Poser 

to avoid the version number. Unfortunately, I didn't think of 

that until it was too late. 

 

Installing New Content 

 

NOTE: Most, if not all, online artists now supply their files as 

ZIP files, which, when extracted, provide the Runtime folder, 

sometimes some sort of ReadMe file, and sometimes some other 

files that you may or may not need. Sometimes the ReadMe file 

(if there is one) is placed inside the Runtime folder, so you 

may have to look for it. 

 

 1. Save the ZIP file from the vendor's site to your hard 

drive. Make sure that you note exactly where you save the file. 

Some web browsers have the option to save the file in a specific 

location. Internet Explorer and Firefox provide a default save 

location in a Downloads folder. 

 

 2. As I described above, if necessary, I create a target 

folder in C:\00-Data\Poser Pro 2012\Libraries\Name. Name is the 

Library subcategory, like Michael 4 or Vehicles, and is created 

if a new type of Library subcategory is needed. Create a Runtime 

subfolder: 00-Data\Poser Pro 2012\Libraries\Name\Runtime. Note 

that I should have named the Poser Pro 2012 folder Poser Pro or 

Poser to avoid the version number. Unfortunately, I didn't think 

of that until it was too late. 

 



 3. I Copy the ZIP file from Downloads to the DAZ3D Store, 

Renderosity Store, or WhatEver Store vendor's folder of my 

Archives folder for safekeeping. 

 

 4. I Move the ZIP file from Downloads to my 00-Temp folder 

in my Downloads folder (to avoid confusion if there are other 

ZIP files present.) To extract the ZIP File, right click on the 

ZIP filename, mouse down to 7-Zip, WinZip or whatever program is 

used to unzip files and choose Extract to Here. The files will 

extract into the same folder where the ZIP file is saved, but 

are sometimes contained in some sort of Contents folder. 

 

 5. Move the Runtime and Readme folders to their final 

destination. Move the Runtime folder to whatever folder holds 

the target Runtime folder. You may be presented with a dialogue 

box asking if you want to proceed with the merge. Choose Yes. 

You may be asked if you want to replace specific files. I 

usually choose Yes. Then Move the ReadMe folder (I sometimes 

rename it to reflect the library items discussed) to wherever 

you want it. 

 

 6. Check Poser to make sure that you can find everything in 

the Library (see the next section for more details.) Then delete 

everything from the 00-Temp folder. 

 

 

[The following information is not for Poser, it is for DAZ 

Studio, but I'm putting it here so I have it if I ever decide to 

actually use DAZ Studio: To use Install files from DAZ, they 

should be installed in your equivalent of 

c:\users\Jack\Documents\DAZ 3D\Studio\My Library. Note: 

"Documents" is "My Documents"] (If I ever decide to use DAZ 

Studio, these instructions may have changed.) 

 

Finding the Newly Installed Content 

 

As Han Solo once said, "Now the 'fun' begins." If you have 

installed a new "character," Jack, for instance, for Michael 4, 

you might expect to find subfolders for Jack in the Michael 4 

subfolders of Pose, Props, and Materials. What you actually get 

depends on what the artist has provided. Maybe there are only 

Props, or only Materials. 

 

As I said above, "Now the 'fun' begins." Artists do not 

necessarily make finding their products easy. If "Jack" is a new 

character for Michael 4, you might expect to find the INJ file 

in Pose > Michael4 > Jack: Jack INJ, a hat for him in Props > 

Jack: Hat, and MAT files to give the hat different colors in 

Materials > Jack > Hat: white, brown, black. 



 

But not all artists will put everything in Jack subfolders. 

Instead, they may use their own cryptic username, like ryan234. 

Or they may place one or two exclamations points in front of the 

name so that Poser alphabetizes it first: !Jack or !!ryan234. 

(This username was probably given in the artist's ad page, so 

you might want to jot it down so you'll know what to look for, 

or if you really like their product, you can use it to search 

for more stuff by them). 

 

Sometimes not even a username is used. I recently found a Hobbit 

character located in FuzzyLogic instead of Hobbit or the 

artist's username. You may have to check the ReadMe file and 

hope that it suggests where the files are stored. Or look for an 

unfamiliar folder name. 

 

Sometimes nothing helps--the item just isn't in the Library. 

I've found two reasons for this:  

 

 1. The artist put the folder into the wrong place in the 

Runtime folder. The Pose folder, for instance, should be found 

as follows: Runtime > Libraries > Pose. I recently downloaded 

some freebies (sometimes you get what you pay for) from an 

artist who used the following file structure: Runtime > Pose, so 

I had to manually move Pose to the Library folder so that Poser 

could find it. Related to this is when the artist misnames a 

folder--Poses instead of Pose. I've had to correct this error a 

couple of times. I'm sympathetic here--I can't remember if it's 

Pose or Poses either and Poser doesn't make it any easier by 

making some library folder names singular and some plural. 

 

 2. You installed Content while the Poser Library was open. 

The Library needs to be refreshed for it to find the new folders 

and files. You can do this by clicking the “Reload Library” icon 

at the bottom right of the Library window (it looks like a tiny 

yin/yang pair of arrows). If your version of Poser doesn’t have 

this button, just close and reopen the Library (or install 

Content while Poser is not running.) 

 

Deleting a Poser Library 

 

On a few occasions, I've been really disappointed with a product 

and wanted to get rid of it. 

 

To delete a Library, open Poser Library. Then Click the Show 

Library Triangle and change from <All> to the library to be 

deleted. Click the [-] Folder (Remove Library) at the top right 

to OK the removal of the library. This does not delete the 

library's folder from the hard drive. So find and delete it. 



 



 Ground 

 

I began using Poser because I wanted to create an image of Gina 

Verucchio which I could then paste into a star field image to 

use in creating a cover picture. 

 

When I saved (exported) the rendered image, I found that the 

image (PNG by default) had a blank background but that the 

scene's "ground" was present as a gray region. If I cut and 

pasted the figure into a star field, the star field showed 

through the background but I had to manually erase the ground 

from the inserted image to allow the star field to show. 

 

The need to erase was eliminated when I found that I could make 

the Ground invisible in the rendered and saved images by 

unchecking Ground Properties for Visible in Raytracing and 

Visible in Camera. Leaving Visible checked allows the Ground to 

be seen while modeling, but not in a render. 

 

Ground in Poser Pro 11 vs. Earlier Versions 

 

In Poser versions through Poser Pro 2014, Ground was just that: 

a plane. However, in Poser Pro 11, Ground is a plane and a dome. 

When Ground is selected in Poser Pro 11, Parameters and 

Properties both treat Ground as a single object. However, if you 

attempt to apply a texture to the Ground, you are given two 

options: Ground or Background. Selecting Ground places the 

texture onto the plane; selecting Background places the texture 

on the dome. 

 

The above options may be of no interest. However, the dome 

portion of Ground is not particularly large and it can block the 

view of more distant features in large items such as TerraDome 

2. To allow TerraDome 2 to be used as it was in previous 

versions, Visible must be unchecked in Properties. I've done 

this and then clicked Set Preferred Scene in General Properties. 

 



Background Color 

 

The Background Color can be set in two ways: 

 

 1.  Display (at the top of the screen > Background Color > 

Select/Create color > OK 

 

 2. Go to the lozenge-shaped icon at the bottom right of the 

Preview Window and Click on the second dot from the left with 

the little color-picker icon that appears > Click on the color 

that you like from the smear that appears or else Click on the 

red-green-blue box at the top right of the Background Color 

window > Select/Create color > OK. 

 

The Background Color of the Preview Window when I first started 

using Poser was a very dark gray. If the image being created had 

a sky dome or some other item to block the background, this did 

not matter to me. When I created images for my catalog, I 

initially ignored the background color. But I eventually noticed 

that the very dark background made some items hard to see. So I 

changed the background color to a light gray and most things 

showed up better. 

 

Yesterday I had a couple of items that I thought might show up 

better with a darker background. But when I went to the color 

picker via method 1 above, the two-row gray scale at the bottom 

of the picker which appears when I want to change Diffuse color 

in the Materials room, was just two rows of white blocks. I'm 

not sure if the gray scale blocks disappeared (they are still 

there when I want to change a Diffuse color) or if they were 

never there. If they have "vanished" I'd like to know how to get 

them back. Interestingly enough, if I go to the color picker via 

method 2 the array is there. 

 

 



 Background Images 

 

Unless the scene being created includes a prop like Millenium 

Environment or some other sort of sky dome, it will have a blank 

background and ground. (I always have the Ground Visible 

Property unchecked.) 

 

A background can be inserted in three ways: 

 

 1. The rendered figure can be cut and pasted into a pre-

existing background image in a program like Photoshop. Make sure 

that the Ground Visible Property is unchecked and the rendered 

image is exported in the default PNG file format so that the 

background is transparent. 

 

 2. A background image can be brought into the Poser scene 

by File > Import. Note: The background image can be seen in 

renders, but if the image is exported in the default PNG format, 

it will not be seen in the saved image. To make the background 

show up in a saved image, it must have been exported in another 

format, such as JPG. 

 

 If the imported image is a different size than Poser's 

window, the program asks if you want to change the window to 

match the background image. As far as I've been able to tell, it 

doesn't matter if you answer Yes or No to this question - the 

background image is resized to fit into the default window. 

Unless the imported image just happens to be the same aspect 

ratio as the window, this will leave blank bars above and below 

or to the left and right of the image. These will be part of the 

final, rendered image. The Render Dimensions can be manually set 

to the dimensions of the background image and the scene will be 

resized to fit into the background image and the rendered image 

will be the size of the original background image. If some other 

Render Dimensions are chosen, the scene will be fit into the 

background image and blank bars above and below or left and 

right will pad the rendered image so that it comes out the 

specified size. 

 

 3. The background images can be placed onto a rectangular 

Primitive prop. I load the HiResSquare from Poser Pro's Props > 

Primitives and change its x or y scale to fit the background 

image's proportions, then scale the prop to the size that I want 

to use. The scene seems to render faster than it does with the 

image imported into Poser's Background. 

 

 



Bookmarks and Hyperlinks 

 

Setting 

 

Place the cursor at the beginning of the word(s) to set as a 

bookmark. Click on the Bookmark (Flag) icon at the top of the 

screen. Type in a Bookmark Name (no spaces if there is more than 

one word; the name can be anything you want) and click Add. 

 

Deleting 

 

Click on the Bookmark (Flag) icon at the top of the screen. 

Scroll down through the list of bookmark names and click on the 

offending name. Click on Delete.  

 

Hyperlink within the same document 

 

Highlight the document text to identify the hyperlink. Click on 

the Insert Hyperlink (Blue Earth and a chain link) icon at the 

top of the page. Click on the Place in This Document box. Scroll 

down through the list of Bookmark Names and Click on the desired 

bookmark. The text selected in the document is now underlined 

and blue. Control-Click on the highlighted text to jump to the 

desired location in the document. 

 

Hyperlink to another document 

 

Highlight the document text to identify the hyperlink. Click on 

the Insert Hyperlink (Blue Earth and a chain link) icon at the 

top of the page. Click on the Existing File or Web Page box. 

Browse through the folders and subfolders to the target 

filename. Click on it then click on Bookmark. Scroll down 

through the list of Bookmarks, select the desired one, and Click 

OK. The text selected in the original document is now underlined 

and blue. Control-Click on the highlighted text to jump to the 

desired location in the target document. 

 

Removing Hyperlink(s) 

 

To remove a single hyperlink, Right-Click on the hyperlink > 

Remove Hyperlink in the drop-down menu. 

 

To remove all hyperlinks, CTRL-A to select all > CTRL-Shift-F9 

 

NOTE: Changing a folder, subfolder, or file name will mess up 

the hyperlinks depending on those names. Dividing a document 

into more conveniently sized pieces does the same because only 

one of the pieces can have the original name, if it does. 

 



 

Cache for Textures 
 

When you render a file, Poser 12 saves the mat files (jpg, png, 

etc) as special files in a folder called PoserTextureCache. I 

presume this is to make a subsequent render of the scene a 

little faster. Unfortunately, Poser 12 does not always delete 

these files when you load something new or when you exit Poser, 

reboot, or turn the computer OFF and ON. This will probably 

never cause any problems, but I have on occasion modified a mat 

file and then saved it with the original name. In this case, the 

Preview window shows an image using the modified file, but 

Rendering will produce an image using the original file. Exiting 

Poser and reloading the scene, rebooting, or even turning the 

computer OFF and ON may not help. 

 

To get the Preview and the Render to match, an easy solution is 

to delete all the files in the cache. The cache can be found at 

 

C:\users\username\AppData\Local\Temp\Poser\12\PoserTextureCache 

 

Although this is a very rare problem, I’ve placed a shortcut to 

the PoserTextureCache folder in my Poser folder on my Desktop. 

Deleting these cached files forces Poser 12 to reload using the 

new file(s) when it renders. 

 

This probably isn’t necessary, but to force Poser 12 to empty 

the cache when exited, go to General Preferences > Render > 

Texture Caching: Persistent Size (MB) from 500 to 0, and 

unchecked Run in Background Thread 

 



 Cameras 

 

Types of Cameras 

 

Poser comes with a variety of cameras to allow you to look at 

and render scenes. 

 

The Face Camera looks at the head, not necessarily the face. It 

can be moved around the head, and closer to or farther from the 

head. Similarly, the Left Hand and Right Hand Cameras look at 

their respective hands, can be moved around each hand, and be 

moved closer or farther. 

 

The Main and Auxiliary Cameras are centered on the x, y, z 

origin of the scene (the axes intersect in the Ground plane) and 

can be moved along these axes with the Dolly X, -Y, or -Z 

Property dials, the Move X and Y, the Move Y and Z, or along any 

axis with the four hand Camera Controls.  The cameras can be 

rotated around the scene axes with the Trackball Camera Control 

or the x-, y- or zOrbit Property dials. 

 

The Posing Camera looks at the x, y, z origin of the currently 

selected figure. These axes remain parallel to the corresponding 

scene axes even if the figure is rotated out of its original 

position. That is, Michael starts out with the Y axis running up 

and down, head to feet, but the Y axis does not change if he 

falls backward. Now it would be the Z axis that ran from his 

head to feet. The Camera Controls (hands and trackball) work the 

same for the Posing Camera as for the Main and Auxiliary 

Cameras, except that the camera moves around the axes of the 

figure, not the scene. DolyX, -Y, and -Z Property dials work the 

same as for the Main and Auxiliary Cameras. The Posing Camera 

has Yaw, Pitch, and Roll Property dials which move the camera 

around the figure's axes like the yOrbit, xOrbit, and zOrbit 

dials. The Poser Pro Reference Manual states that these controls 

turn the camera around its own axes (i.e., yaw would be like you 

are turning your head to look left or right). But that doesn't 

happen because the camera must always be looking at the selected 

figure. So, when you use these dials, the camera does rotate 

around its own axes, but only because the camera rotates around 

the figure's axes as it does so. The effect of yaw and yOrbit 

are exactly the same except that different y axes are involved. 

Yaw, Pitch, and Roll work exactly the same way on the Face, Left 

Hand, and Right Hand Cameras. 

 

The Dolly Camera is the camera that you can point wherever you 

want. It starts out pointing at the Scene's origin, regardless 

of what figure you have selected (Like the Main and Auxiliary 

Cameras). Like the other cameras, its location can be translated 



along the scene's X, Y, and Z axes by the Camera Controls or 

Property Dolly dials. Its yaw, pitch, and roll dials work like 

you would expect. Yaw rotates the camera around its Y axis (like 

turning your head to look left or right). Pitch rotates the 

camera around its X axis (like looking up or down). Roll rotates 

the camera around its Z axis (like tilting your head to the 

side). 

 

Saving a Camera Setup 

 

All the experimenting that I've been doing has got the cameras 

moved around to unknown locations, so I've not been sure just 

where any particular camera was located. So that I can start off 

in a useful configuration, I've moved each camera into a 

desirable (to me) location, then saved the setup into the 

Library. This was done as follows, more or less as described in 

Tutorial 2.2 in Practical Poser 8: The Official Guide: 

 

Load a figure (Michael 4). Select each camera in turn and use 

the Camera Controls to "move Michael" so that he is a convenient 

size and oriented as you'd expect to see him (i.e., facing the 

Main Camera with his arms pointing left and right, etc.) For the 

Top Camera, I "moved Michael" far enough away that I could see 

the icons for my lights. I then deleted Michael, although I 

suspect that this was not necessary. 

 

To save this setup: Open the Library > Camera. Click on the 

Poser Pro 2012 triangle to select and open it. Click the Add 

Folder button and give it a name (I chose Jack's Defaults.) This 

new folder now appears along with the others. Click on the 

folder to highlight it. Click the Add to Library button and Name 

it (again, I chose Jack's Defaults.) Click the Select Subset 

button. I selected all the cameras (but you could select only 

the ones that you wanted if you were making some other setup.) > 

OK > OK. Select Single Frame > OK. The new setup can now be 

selected from the Library any time it is desired. 



 Clothing 

 

Dynamic Cloth 

 

Many clothing items that come as Figures can be made to pose 

with the Character by Conforming them to the Character. Some 

come as props and have no Conform function. These must be posed 

with the Character as Dynamic Cloth in the Cloth Room. For more 

information, see Dynamic Cloth. 

 

Poke Through 

 

Michelle T-shirt and Anjiru top will not cover My Shorty shorts 

properly. The shorts show through the bottom of the shirts. This 

can be fixed by selecting the hips of the shirts and changing 

the value of Morph/PBMAdjustHips. 

 

Changing the pose may cause body parts to stick through the 

fabric. Increasing the Morph value of that part of the shirt may 

solve the problem. 

 

For more information on fixing this problem, see Poke Through/In 

 

Colors 

 

If clothing does not come with MAT files to provide the correct 

color, the color can be changed by going to the Material room 

and removing the maps and/or changing the colors in Diffuse, 

Highlight, Ambient, or Reflection. 

 

CrossDresser 

 

CrossDresser is a program which converts clothing for one Poser 

character into clothing for another character. For information 

about using this program, see the CrossDresser section. 

 

Fitting Clothing for the Right Figure 

 

By “Right Figure” I mean the figure that the clothes were 

intended for – Dawn clothes for Dawn, Michael 3 clothes for 

Michael 3, etc. To fit clothes for the “Wrong Figure” (Michael 4 

clothes applied to Michael 3, for example), see the next section 

below. 

 

What follows was originally researched for HiveWire 3D's Dawn 

character, but may be true for other characters, like Victoria. 

 

When clothing is loaded to a figure, it may or not fit properly. 

The first thing to try when it does not is to Conform the item 



to the character. This usually works, but sometimes you still 

have some Poke Through, which may be fixed as described in the 

Poke Through/In section. Sometimes the clothing comes with its 

own morph dials which can be used to fit it to the character. 

These morph dials may be just for popular/current characters. Or 

they may provide adjustments for various body parts. In this 

latter case, they may not work if the item has been conformed to 

the figure - so unconform the item, make the adjustment, then 

Parent (not Conform) the item to the character. 

 

HiveWire 3D's Dawn character has gone through a number of 

character iterations (Dawn, Dawn Special Edition, Type-# Body) 

as well as a number of character Pose INJ morphs. The same is 

true of other characters, like Victoria. Each of these new Pose 

INJ morphs can have their own body shapes. This can cause 

problems when clothes originally designed for one character 

version are to be used on a version introduced at a later date - 

the clothing may not fit the newer character. 

 

After consulting with HiveWire 3D Tech Support and doing a bit 

of experimenting, I have come up with one way that may get the 

clothes to fit: 

 

 1. Load the character 

 

 2. Load the clothing 

 

 3. Conform the clothing to the character 

 

 3B. A shortcut would be to load the character, then drag 

the clothing from the Library and then drop it onto the 

character. It automatically conforms to the character. 

 

 4. Dial in any available character morphs 

 

 5. If the clothes do not morph to fit, try dialing in 

corresponding morphs from the clothes dials. If there are no 

morphs available, try the following procedure which I have 

copied from an online tutorial by Ken (creator of the Body Type-

# series for Dawn.) A link to the tutorial is: 

https://community.hivewire3d.com/threads/ken1171s-products-at-hivewire3d.862/post-
181356 
 

 1. Load the default character, the INJ morph, clothes, and 

find the clothes cannot be made to fit by other means (above.) 

 

 2. Select Textured Lined for the Preview window (the last 

of the Document Display spheres in my Poser Pro). I'm not sure 

this is really needed, but Ken did this in his tutorial. 

https://community.hivewire3d.com/threads/ken1171s-products-at-hivewire3d.862/post-181356
https://community.hivewire3d.com/threads/ken1171s-products-at-hivewire3d.862/post-181356


 

 3. Make sure the clothing is selected. 

 

 4. Click on the little white triangle in the upper right 

corner (just to the right of the Parameters and Properties tabs) 

and select Show Hidden Parameters from the drop down menu. 

 

 5. Select Figure > Copy Morphs From > "Base Character" > 

Select All > OK 

 

 6. Wait for Poser to make the adjustments. The clothes now 

fit, or do they? I ended the previous sentence with a question 

mark because in Ken's tutorial the clothes he used just fit 

"better" and he needed to go through steps 7 - 10 below. 

 

 7. From the Editing Tools (Upper left corner) select the 

Morphing Tool (pointing finger icon) 

 

 8. In the Morphing Tool window that opens, select Select or 

Create Morph > New > OK to use default name 

 

 9. If there are wrinkles in the new fit, choose the 

Smoothing Tool (icon look like the bottom of a steam iron) and 

use the "Brush" (circle full of colored dots) to smooth the 

wrinkles. 

 

 10. If there is Poke Though, choose the Pull Tool (icon is 

a down arrow) > Surface > Magnitude = 0.03, and use the Brush to 

pull the clothes out from inside the character. 

 

 11. Close the Morphing Tool and go back to Texture Shaded 

Mode 

 

 NOTE 1: I have not done much experimenting with Ken's 

technique, but I could see no change when using his Copy Morphs 

when trying to fit Space Cadet dress to Victoria 4/Danielle. 

Going on with the Pull Tool worked, but a little Poke Through 

came back when I tried posing the character. 

 

 NOTE 2: If you are likely to want to use a particular item 

of clothing in the future with the same new character, you might 

want to save it to your Library (with a unique name - in my case 

I named the dress "Space Cadet Danielle). Make sure that it is 

the clothing that you have selected when you do this! I found 

that I needed to deal with a little Poke Through even after 

loading the saved dress to a new Danielle character. I used the 

Pull Tool to eliminate that Poke Through and saved the dress 

again. This time it loaded properly. 

 



 NOTE 3: Don't use the Drag and Drop clothes shortcut with 

clothes that have been modified and then saved. This shortcut 

automatically conforms the clothes to the original, default 

figure, not the new INJ figure. 

 

Fitting Clothing for the Wrong Figure  

 

By “Wrong Figure” I mean selecting clothes made for Michael 4 to 

dress Michael 3, for example. 

 

Although clothes for Michael 4 may be conformed to and made to 

fit Michael 3 (in the default pose), when a Pose is injected 

into Michael 3 the M4 clothing may ignore the Pose. However, if 

the same Pose is injected into the M4 clothing, it may take on 

the desired pose. Some changes in the x, y, or z position or 

scale and the morph tool may be needed to get it to fit the 

character’s new position. 

 

How well this works will depend on how similar the two 

characters are. 

 



 

Composing a Scene 

 

Composing a scene involves placing models (figures and props), 

lights, and Cameras in the 3D space to give the image that you 

want. This can get tricky the farther from the origin these 

things are located. 

 

 Moving Figures and Props 

 

Figures tend to load at the origin and then are dragged and 

dropped to the desired location. Where props, on the other hand, 

may load is anybody’s guess. They may load at the origin. But 

they may also be “smart propped” to some other location selected 

by the item’s creator--such a sword into a character’s hand, or 

a tree to the northwest corner of a town. They can still be 

moved in the same ways that you move Figures to the desired 

location. 

 

If the figure is a character, like Michael 4, I find it simpler 

to leave the character at the origin while clothing and related 

props are added to him. They can then be conformed or parented 

to him. If there are other things already loaded, like 

buildings, then the character may be hidden from view. Switching 

from the Main to the Face Camera can allow you to see the 

character before you add these other assets or poses. 

 

If the Figure or Prop is to be moved a long way from the origin, 

like in a forest, city, or other large scene, then switching to 

the Top Camera can be helpful. Click on the red circle around 

the Figure and drag and drop it in the x/z directions to get it 

to the approximate location desired. If the asset is a Figure, 

make sure that its Body is also selected. Figures often load 

with Hip selected I have no idea why. It seems stupid to me, but 

that’s the way it is. Selecting the Hip before dragging 

sometimes deforms the Figure. Sometimes it doesn’t seem to 

matter, but if you later select Body and want to use the x/y/z 

dials at the right, it may seem to still be at the origin. 

 

If the Top Camera has been moved very high, then the Figure may 

be hard to see. Trying to click on the small red circle and then 

dragging may result in something else in the vicinity getting 

selected and dragged. Very annoying! Moving the Top camera 

closer or, temporarily, enlarging the Figure’s scale may give a 

circle large enough to easily drag and drop. 

 

If you know the coordinates of some other object in the vicinity 

of where you want to move your asset, then setting the 

Translation dials at the right can get you close to your 



destination. Rotating the dials or setting the x- and then the 

zTranslation coordinates digitally can also let you see how 

close to your destination you are getting. Sometimes these dials 

have names different from their default names--such as Up/Down 

for yTranslate. 

 

Setting the final position is better when viewed close-up. I 

generally use the Main Camera, sometimes the Dolly Camera, to 

compose my overall scene and create my final image. So I hate to 

move it to get close enough for fine adjustments when bringing 

Figures and Props together. For instance, to put a Hat onto 

Michael (if Conforming doesn’t work) or onto a Hat Rack. 

Selecting Michael and the Face Camera lets me do the fine 

adjustments. If the Hat is a Figure, then selecting the Face 

Camera may also let you bring the Hat and Hat Rack together. If 

the Face camera doesn’t work for you, selecting the Aux Camera 

can let you avoid moving the Main Camera. 

 

Moving Lights 

 

I’ve set my default NEW scene to contain a 3-Point light system 

(Key, Fill, and Back) located around and above the Origin. For 

small scenes located near the Origin this works well. Moving the 

lights with the Translation Dials and watching how the lighting 

on the scene changes often works well. Not so well as the 

distance from the Origin increases, except, perhaps, for the Y 

coordinate. 

 

The x/z coordinates of the Lights can be changed, as for Figures 

and Props, by viewing with the Top Camera. However, the Lights 

just show up as tiny red dots when selected. (NOTE: The Light 

must be selected from the Drop-Down menu above the dials at the 

right.) Trying to click and drag that tiny red dot often results 

in selecting and dragging some other item. Fortunately, there is 

a solution for this problem. 

 

Just like Figures and Props, Lights have Scale settings at the 

right when selected. Changing the Scale from 100% to 500% or 

1000% increases the circle to a pair of red circles that are 

much easier to see, select, and drag. The circles can also be 

seen with other Cameras. They can even be seen as a pair of 

black circles when not selected, so you still have some ideas of 

where they are. And, as far as I can see, changing the scale of 

a light 5 or 10 times has NO EFFECT on how bright it is--it’s 

just a lot easier to see and move around. 

 

 

 

 



Moving Cameras 

 

Cameras, like Figures, Props, and Lights, can be moved around. 

Unfortunately, like Lights, they are hard to see from far away. 

Up close, they look like aa wire-frame image of a video camera. 

But from farther away they just look like tiny red spots, much 

like the Lights do. Unfortunately, unlike the Lights, increasing 

their Scale has no effect. 

 

Viewed with the Top Camera, a selected camera is seen as that 

little red spot. It’s x/z coordinates can be set, just like 

anything else’s, with the Translate controls. HOWEVER, you can’t 

see that they’ve moved to the new position when you do that. For 

instance, if you want to move the Main Camera from x = 0 to x = 

500, set xTranslate to 500. The red dot hasn’t moved. So, from 

the Camera Controls at the left, switch from Top Camera to Main 

Camera. (Things should look different!) Now switch back to the 

Top Camera. That tiny red thing should now be moved to the new 

location. If that’s not quite where you want it, do it again. 

Same with the z coordinate. 

 

 

 

 



 Creature Creator 

 

Watch out for morphs which may or may not make obvious changes 

in the object to be altered. 

 

Although I had no use for Creature Creator (converting Michael 4 

or Victoria 4.2 into "creatures", I was curious to see what 

Michael would look like with ram's horns. So I loaded the 

Michael 4 figure, then tried to add the left and right ram's 

horns (Pose > Michael 4 > DAZ's Michael 4 > Add-Ons > Creature 

Creator). But nothing happened. 

 

I finally got around to checking with DAZ Tech Support and was 

told that before adding the Ram's Horns, I had to add the 

Universal Horn (actually, two of them) from Figures > Michael 4 

> DAZ Characters > M4 Creature Creator. 

 

So, be careful when adding what you might think are props. They 

might actually be "morphs" INJ files that modify some other 

item. Sometimes, like Creature Creator, you can see the morph. 

But sometimes you can't! In fact, a Parameters Dial may have 

been added unbeknownst to you and no morph will take place until 

you find the dial and adjust how much morph you want. 

 

 



CrossDresser 

 

CrossDresser is a program which converts clothing for one Poser 

character (like Michael 4) into clothing for another character 

(like Yweeb). The program is a free download from EvilInnocence 

but you must purchase a “license” which enables you to download 

the files necessary for converting clothing to fit the target 

character (Yweeb) to your computer. Files for source characters 

(Michael 4, not his clothes) are free and obtained by “updating” 

your program. For example, I wanted to convert clothing in my 

Poser Library for Michael 4 to something that would fit Yweeb. I 

had to purchase and install a license for Yweeb and update my 

CrossDresser program to recognize Michael 4. 

 

I’ll try to explain how all this works in the following: 

 

Downloading and Installing CrossDresser: Go to the EvilInnocence 

web page at https://www.evilinnocence.com/ Click on the 

CrossDresser tab at the top of the page > Click the Download XD 

Program button. Exit the browser when the download is finished. 

Unzip the XD 4 Installer file, then run the XD 4 Installer 

program. (The current version is 4.) Shortcuts for XD4, XD 

Morpher, and XD Updater will be placed on the Desktop. (I don’t 

know what XD Morpher does yet.)  

 

Getting a license for your Target Figure: I wanted to be able to 

convert clothes to fit my new character, Yweeb. Go to the 

EvilInnocense web page and go down to the Store Links column. 

Click on CrossDresser Licenses. Find Yweeb, click on him, put 

him in your cart and check out. Login or create an account if 

you don’t already have one. Pay for the license and download it. 

Unzip the installer and run it just like you did for 

CrossDresser.  

 

NOTE: Finding the license you want may not be too easy. You may 

have to look through page after page until you find what you are 

looking for. You might enter your character into the Search 

Entire Store window. But I entered “Michael 4: CrossDresser 

License” (at their suggestion) and unbelievably came up with 990 

hits to search through! There is a Sort window which allows you 

to select Name and search an alphabetized list A-Z (↑) or Z-A 

(↓).  

 

Run the XD Updater program: Click Next to step through Program 

Update, Install New Figures, Install Updated Figures, Install 

Skipped Figures, then Update. The first three steps will 

probably have blank windows. If not, do whatever is called for. 

Step 4 Skipped Figures will have a list of source figures. 

Select (CTRL-Click lets you select more than one) the names for 

https://www.evilinnocence.com/


figures in your Poser Library that have clothes that you will 

want to convert for someone else. There are over 100 choices 

here, so stick to the ones that you need now (to save disk space 

and update time). You can run the Updater again if you need more 

later. The Progress Bar may keep running when the Update is 

finished, but when you see Done at the bottom of the window, you 

can exit. 

 

Run CrossDresser: The first thing that you need to do is to tell 

it what clothing to convert. Until I find a better way, this is 

what I do: Minimize CrossDresser (It’s icon in the Task Bar at 

the bottom of the Desktop is mostly black, so it’s almost 

invisible. But it will be underlined with a blue line, so you 

should be able to find it later.) > Run Poser and find the item 

of clothing that you want to convert. > Cursor over the item. A 

little bar with the path to this item may appear. Ignore it. > 

Right-Click on the clothing’s icon. A little window that says 

“Show in Explorer” opens. > Click in the Window. > A window 

opens showing files and the path to them. Click in the bar that 

shows the path to select the path > CTRL-C to copy the path to 

memory > Close the window > Restore CrossDresser > Click on the 

Choose Clothing button [...] in the Clothing to Convert window. 

> Click in the bar that shows a path to select it > CTRL-V to 

paste your saved path into the bar > Enter > Double-click on the 

file for the item of clothes that you want to convert > the 

filename appears in the Clothing to Convert box > In the Figures 

box, select the From and To characters > Click Convert > Wait a 

few seconds while the conversion is made, then close 

CrossDresser.  

 

Find the converted clothes: Your new clothes will be in a 

folder, !Converted, in the same Library folder that the source 

item’s folder was located. That’s saying “folder” a lot, so for 

example, Suppose I wanted to convert Michael 4’s “Fancy Shirt” 

to something for Yweeb, “Fancy Shirt” was in Figures > Michael 4 

> Handsome Dude. “Yweeb - Fancy Shirt” will be found in Figures 

> Michael 4 > !Converted. 

 

Poke Through: If you are lucky, “Yweeb - Fancy Shirt” will fit 

your Yweeb character fine. If you aren’t so lucky, you may have 

to deal with poke-through just like you would for any other item 

of clothes. But CrossDresser does have an advanced option that 

allows you to make the converted clothes stay a bit farther from 

the character so poke-through may be reduced or avoided. I 

wanted to convert Office Suit IV for Victoria 4 to fit Yweeb. I 

converted the Jacket, Shirt, and Skirt. The Jacket converted 

fine. The Shirt had multiple poke-throughs. The Skirt had only 2 

spots, at the hip. Clicking on the [>] button at the right of 

the Lower Body Options box provides More Options. Check the Fix 



Poke box and set the amount. Setting the amount to 1.0 fixed the 

skirt. Setting the amount to 2.0 fixed the shirt. But when the 

Jacket and Skirt were put on Yweeb with the Shirt, they both 

showed the shirt poking-through. (I wasn’t surprised.) 

Reconverting them with the Poke Through amount set to 2.0 for 

each fixed the problem. Re-Converting an item overwrites the 

previous item in the !Converted folder, so you don’t have to 

worry about a bunch of similar copies (although there might be 

occasions where this would be useful.) 

 

Props: Browsing through Michael 4’s clothing, I noticed that 

shirts, jackets, pants, shoes, and socks are Figures. Clothing 

props are items like hats that can be fitted to different 

characters by just changing the scale. 

 

Universal Clothing. If you look around a bit on the 

EvilInnocense page you may see something about a plugin for 

Universal Clothes. Apparently Universal Clothes can be 

downloaded for free at the site and can then be used in Poser 

just like regular clothes, but without the need to run them 

through CrossDresser. I haven’t done anything yet except to 

notice that they do have a lot of clothes. But I don’t know if 

they have anything I want. If I do anything about this plugin 

later, I’ll update this section. In the meantime, I’ll stick 

with XD 4... 

 



Depth Cues 

 

As you look through a fog, objects get harder to make out the 

farther away they are. The same is true when you are looking at 

objects while under water. How difficult an object is to see is 

a "depth cue." 

 

Poser scenes normally have no depth cues, unless you make use of 

its Depth of Field effect. Poser can simulate depth cues in the 

Materials Room in either of two ways. 

 

 1. Go from the Preview Room to the Materials Room. Select 

Atmosphere from the Objects Drop Down Menu. Go back to the 

Preview Room and load a MAT from a provider which is intended to 

show depth cues. This MAT may also provide a map for additional 

haze or murkiness to the scene. 

 

 2. Go from the Preview Room to the Materials Room. Select 

Atmosphere from the Objects Drop Down Menu. Manually set 

necessary variables in the window that opens. Return to the 

Preview Room. 

 

Note that you may not see any depth cues while in the Preview 

Room 

 

To create depth cues by the manual method, do the following: 

 

 1. Check the Depth Cue On box 

 

 2. Set the Highlight Color to a preferred color. To create 

a fog, set the color to White (if you want a red fog, set 

Highlight to Red.) For underwater, some blue, green, or blue-

green color is probably preferable. 

 

 3. Set the Start Dist and End Dist if needed. When you 

render your scene (not before), these are the distances from the 

camera that the depth cues will begin and end.  

 

 An object appears to be viewed with in increasing density 

of the Highlight Color the farther from the Start distance it 

is. The narrower the Start-End distance range, the denser the 

color and vise versa. 

 

 The Start Dist seems to have a maximum distance of 83.333, 

so problems might occur if the camera is too far from the 

objects in the scene. 

 



 The End Dist default is 125, but it changes to 83.333 if 

you try to change the setting to something slightly less. Values 

less than 83.333 are fine. 

 

 4. Return to the Preview Room after making your settings. 

Remember that you cannot see any depth cues while in the Preview 

Room 

 



 Depth of Field 

 

Depth of Field is the region of an image that is "in focus" - 

i.e., sharply defined. Outside this region, the image is "out of 

focus" - blurred. The image is always displayed in focus in 

Preview mode. Images are rendered in focus unless the Depth of 

Field option in Render Settings is selected. 

 

Depth of Field is determined by Camera settings. 

 

The center of the in focus region is specified (I think) by the 

camera's Focus-Distance setting. Note: This is the distance from 

the camera, not from the scene's Origin. 

 

Since no depth of field effect is seen in Preview Mode, the 

Focus-Distance is best set with its dial. When the dial is 

turned, cross hairs appear and are moved through the field of 

view. Turn the dial until the center of the cross hairs 

intersects the part of the image where you want the center of 

focus. Ignore the disk at the center of the cross hairs. 

 

The width of the in focus region (the depth of field) is 

determined by two camera settings: Focal (focal length) and 

fStop (f/ stop). The smaller the Focal setting, the wider the 

depth of field (and the wider the field of view.) The larger the 

fStop setting, the wider the depth of field. 

 

Make sure that the Depth of Field option in Render Settings is 

selected, then do test renders and make changes in Focal and/or 

fStop until you get the effect that you want. Because Focal 

determines the field of view - 50 mm is the "normal" view of a 

35 mm camera, longer focal lengths are "telephoto," and shorter 

focal lengths are "wide angle," - adjusting the fStop is 

probably the preferable adjustment. 

 

Remember - if you move the camera, you move the spot at which 

Focus-Distance is centered. If you change cameras, all settings 

are changed to the new camera's settings. 

 

One other note: Images imported into Poser's Background will 

render in focus, even if their location would suggest that they 

should be out of focus. To make a background image render out of 

focus, load the image as a Diffuse Map onto something like a 

Poser Primitive HiRes Square in the Materials room, then resize 

and position it in the background of your scene. 

 



 Dynamic Cloth 

 

While attempting to use the Ladies in Waiting Windsor Dress by 

AWycoffStudio with Victoria 4.2 in a scene, I found that I could 

not get it to assume Victoria's pose. It had no Conform function 

and Parenting did no good. Nothing was said about this in their 

ReadMe file. I assumed that something was wrong with the dress 

and purchased another, the Praeclarusa 2 Burgundian Robe by 

Digital Lion/SaintFox. It could not be posed with Victoria 

either. And this model came with no ReadMe file. 

 

I eventually realized that both models were Props, not Figures 

(which have the Conform function.) While investigating this 

"peculiarity," I found that the ad for the Praeclarusa robe 

mentioned a tutorial for using the dynamic cloth gown. As of 13 

November 2016, this tutorial was at http://german-

3d.com/tutorials/ Praeclarusa2-tutorial/BurgundianRobe-

tutorial_b.htm 

 

I also found another tutorial for using dynamic cloth at 

http://www.chez-annick-et-marc.net/poserdynamic2.html 

 

Between the two tutorials and a bit of experimenting, the 

following procedure has been distilled which works with both the 

Windsor Dress and the Burgundian robe: 

 

 1. Load, pose, etc. whatever parts of the scene you want 

(those without dynamic cloth.) 

 

 2. Load Victoria 4 (or whatever character you want to wear 

the dynamic cloth. Uncheck Inverse Kinematics (from Figures drop 

down menu) if necessary (default is Unchecked). 

 

 3. Load and Conform/Parent other items for Victoria 

(character INJ, hair, other Props/Figures). 

 

 4. Make sure Victoria/Body is selected and load the dynamic 

clothes (there may be more than one item) and make sure all are 

Parented to the character or other item of clothes. CAUTION: 

They may not stay Parented! Move the Character to the desired 

location. 

 

 5. Open Window > Animation Controls. Set to Frame 30. 

 

 6. Load the desired Victoria Pose morph. If her hands touch 

her body or the clothes, move them to provide a bit of room 

between them for the cloth. 

 

 7. Go to the Cloth Room. 



 

 8. Click on New Simulation button 

 

 9. Check Box Cloth Self Collision > OK 

 

 10. Click Clothify button 

 

 11. Find the innermost item in the List and click Clothify 

(the view shown returns to Frame 01) 

 

 12. Click on Collide Against button > Add/Remove. Check 

anything that might come in contact with the Gown. It is 

probably okay to uncheck Hair. > OK > Also probably okay to 

check Ignore Head > OK. Return to Step 11 and Clothify the next 

outer item, etc. 

 

 13. Save - just in case! 

 

 14. Click Calculate Simulation button. This takes a while 

as it goes through Draping, Calculating Dynamics, Simulating 

Frames. 

 

 15. Save - again 

 

 16. Render at Frame 30 to see how it looks 

 

 17. If necessary, return to the Pose room to change the 

pose slightly, then recalculate the simulation. 

 

 18. Go on with the Scene: Do everything else at Frame 30. 

 

 19. Uncheck the Animation Controls window when done. Make 

sure to open it again and set to Frame 30 if the file is loaded 

again. 

 

NOTE: I haven't had much experience with Dynamic Cloth and the 

Cloth room. For instance, I haven't tried more than one figure 

wearing Dynamic Cloth. So these instruction may be amplified or 

modified if I do more. (I’ll probably avoid Dynamic Cloth!) 

 



 Elite Ethnic Morphs 

 

DAZ Studios provide morphs, Elite Ethnic Faces, for either 

Michael 4 or Virginia 4 to change their default faces into 11 

other ethnic types: Aborigine (Australian?), American Indian, 

Asian (East), Bushman, Indian (from India), Eastern European, 

Eskimo, Ethiopian, Norwegian, Polynesian, and South American 

Indian. 

 

No change in eye color or skin color is provided. These must be 

loaded separately. 

 

Following are directions and comments about using the Elite 

Ethnic Faces morphs: 

 

Load a Michael 4 or Virginia 4 figure and then load the 

corresponding Elite Ethnic Faces. 

 

Select the figure's Head to show the morphs available in the 

Properties window. 

 

The Michael 4 morph set is found under the International 

Properties and is divided into 5 sections: Full Head, Face, 

Eyes, Nose, Lips. Each section contains named dials for the 11 

ethnic morphs. 

 

The Virginia 4 set is found under the Morph Properties and is 

not conveniently divided into sections, just into a column that 

contains all the dials. The dials are named with the ethnic 

type. Faceshape, Eyes, Nose, and Lips are named for each ethnic 

type. The dials corresponding to Full Head have only the ethnic 

name. Good luck in sorting things out. 

 

There are 2 ways to select an ethnic type: Set the Full Head 

Properties dial to 1.0 (quick and easy) OR Set each of the 

Faceshape, Eyes, Nose, and Lips dials to 1.0. I recommend that 

you DO NOT set all 5 dials to 1.0. Setting the Full Head along 

with the other 4 features provides very exaggerated, sometimes 

unreal, results (more so for Virginia than for Michael.) 

 

For some reason, each of these two methods produces very similar 

but not necessarily identical results. You probably won't notice 

the difference unless you render each and quickly switch back 

and forth between the renders to notice the differences (like 

looking for the "planet" Pluto way back when.) 

 

Because each of these features are set by dials, you can mix and 

match among the various ethnic types of you wish. 



 Exclamation Points (!) in File Names 

 

File names in the Poser Library sometimes begin with an 

exclamation point (!). These are not necessarily exciting files. 

In Windows, a ! at the beginning of a file or folder name causes 

the folder or file to be listed ahead of the normal alphabetic 

order. The modeler has probably done this so that you can more 

easily find files that should be loaded before others, or that 

are Preload files. I tend to put zeros (0 or 00) in my file or 

folder names to do the same thing. 

 

 

 



 Eyes 

 

Eye Colors 

 

Somewhere, most models come with an assortment of eye colors. 

MATs are not necessarily specific to the model they accompany. 

It may depend on the model. 

 

I wanted to use the Maya form for Victoria 4 as the base for my 

Tahiti figure. But Maya comes only with a selection of brown 

eyes, and I wanted Tahiti to have blue eyes. So I loaded 

Amalie's Blue_1 eyes into Tahiti. The Preview looked great, but 

when rendered, the eyes fogged over. I tried a variety of 

Materials changes but never found the right settings to correct 

this. 

 

Aiko 4 comes with blue eyes, although they are anime styled 

eyes. In desperation I tried these. They looked fine in the 

Preview, not even those bug eyes of the anime characters, and 

did not cloud over when I rendered them. 

 

Point At 

 

The default position for eyes seems to be looking straight 

ahead. This gives characters that dreamy, "deer in the 

headlights" look. Eyes can be posed to look into the camera or 

in some other direction, but this can be a lot of extra work if 

you are changing poses and/or camera positions a lot. 

 

Point At, in the Objects drop down menu, can be a help. You can 

select each eye, choose Point At, and click on the item that you 

want the eyes to look at. Now, whenever you change the pose of 

the model, her eyes will track the chosen item. 

 

I was doing some "portraits" and wanted the eyes to look into 

the camera as I moved it about. This is done the same as for any 

other item that you want the eyes to point at. However, I was 

using the Face Camera for the portraits. I could find all 

cameras but the Face Camera in the list of items in the scene. I 

thought that perhaps it was there under some other name (The 

people providing the models have the terrible habit of providing 

one name one place but changing it to something different 

somewhere else: Watch out!). But no, the list of cameras 

included no "extras" - all but the Face Camera were there. Since 

the Face Camera is the most appropriate camera for doing 

portraits, I tend to think this is rather stupid. 

 

To get a "Face" camera that the eyes can point at, I moved the 

Aux Camera up close and in a position to simulate the Face 



Camera. I set each eye to Point At the Aux Camera. Now when I 

moved the camera around a little, the eyes gazed into the camera 

and gave a more realistic look to the model. I'm sure that you 

could do the same thing with the Main or Dolly camera. Remember, 

if your character looks directly into the camera, you get one of 

those pictures where the "eyes follow you around the room." I 

like that, but you might want to have the character look at 

something else if you find it a bit spooky. 

 



 Genesis by DAZ 3D 

 

The following paragraph is a description (copied from their home 

page) of what DAZ 3D refers to as their "Genesis" figures: 

 

Genesis 2™ is the latest version of the Genesis base that DAZ 3D 

figures are built on.  Think of it as a “figure platform” that 

is the foundation of  every other DAZ 3D character shape.  This 

means that all of our characters can be morphed into nearly 

anything from a small child to a giant troll. Add fat, skinny, 

muscular, alien, Minotaur, or any mix-and-match variations in 

between.  Think of Genesis 2 as the clay that lets you literally 

dial-in your own creation.  And when you’re done, being built on 

Genesis 2 means your creation will still be fully rigged, 

posable, animatable, and realistic.  Additionally, the thousands 

of accessories such as hair, weapons, clothing and more will 

seamlessly work with your new design.  Then will, [sic] shrink, 

stretch, fit, and move as needed. 

 

I'm not sure that "seamlessly work" is the best way to describe 

the Genesis experience. For example, (if Genesis works the way 

that I think it's supposed to work, and maybe I'm thinking 

incorrectly), I should be able to load in a character such as 

The Girl 6 and then dial in the face of Victoria 6 to end up 

with a model which has The Girl's body and Victoria's face. But 

that doesn't work. The Girl's face is changed, but it doesn't 

change into Victoria's. To get Victoria's face on The Girl's 

body (more or less - more about that below), do the following: 

 

Load the Victoria 6 character, then select Actors > Full Body > 

People > Stylized > Girl 6 Body = 1.000 

 

However, if you compare the figure of the character just created 

with the default The Girl 6 figure, they are not the same. The 

new figure is considerably more buxom than The Girl 6. This may 

be because Victoria 6 is a slightly larger character than The 

Girl 6. 

 

Going back to the "seamlessly work" statement, I would think 

that this would mean that I should be able to take clothes 

originally created for some specific Genesis 2 character, such 

as the String Bikini for Victoria 6 and place it onto some other 

character, such as The Girl 6 or the combination character that 

I just described above. Even after "Conforming" the bikini top 

to either of these characters, there is still "show through." I 

wouldn't call this process "seamless." Poke through can be 

eliminated by selecting various parts of the bikini top and 

scaling them each to something a little over 100%. According to 

Mariah at DAZ 3D,  this is the proper way to get clothes to fit. 



 Genesis in Poser Pro 11 

 

Note: The information following this NOTE may be of use only if 

you still have Poser Pro 2012 and the original Poser Pro 11. I 

have updated to Poser Pro 11.3 and have done practically no 

testing with the Genesis version which requires the DSON 

importer. The only things that I have noticed are 1) I can load 

more than one of the Genesis "6" characters into a scene, and  

that if I try to load a new PZ3 file, or to NEW, Poser 11.3 

closes if a DSON character (or my "Psr" characters) was present 

in the scene being replaced. 

 

Note: Genesis 3 (and above) figures have no DSON importer, so 

they cannot be used in Poser. 

 

Part 1: Library Problems? 

 

I installed Poser Pro 11 when it first came out. At that time, I 

found that it would not load more than one Genesis (or Genesis 

2) Figure or Prop which required DAZ's DSON Importer. Once the 

DSON Importer has done its job, nothing else anywhere in the 

Poser Library could be loaded. I discovered today (3 September 

2016) that this is no longer a problem. I loaded five Genesis 2 

figures into Poser Pro 11 without a hitch. I then loaded a 

couple of other non-Genesis figures - still all okay. Apparently 

a Poser update sometime since I installed Poser Pro 11 has fixed 

the problem. If you find that your version of PP 11 still 

exhibits this problem, you probably want to check into my 

workarounds in Part 3, below. 

 

Part 2: A remaining problem 

 

Because of the above mentioned problems, I've been reluctant to 

move from PP 2012 to PP 11. But today, just out of curiosity, I 

decided to load a file created a while back with PP 2012 which 

contained some of those roll-type window shades. When rendered 

with Firefly in PP 2012, a partially shaded blind came out with 

small light and dark squares instead of the expected shading. 

Would the render work better in PP 11? 

 

The short answer is "Yes." BUT, as the file loaded, it stopped 

because it could not find a particular file. When I told it to 

skip the file, the image eventually loaded. I rendered with 

Firefly (I still don't care for Superfly.) and the window shade 

was rendered correctly. BUT, a Brodie 6 character (Genesis 2) in 

the scene was completely naked! (He wasn't supposed to be 

naked.) I presume that this has something to do with that 

skipped file. I haven't taken the time to investigate this 

further. For the moment I won't be surprised if older files 



created with PP 2012 and containing Genesis/Genesis 2 figures or 

props might not always work as expected in PP 11. 

 

Part 3: Workarounds 

 

If you find that Poser Pro 11 shows the problems describe above 

in Part 1, you might like to try something from this section. 

 

I downloaded and installed the latest DSON Importer and Starter 

Essentials files, but this made no difference. I contacted DAZ 

Tech Support and got this response: "Unfortunately at this time 

DSON is not compatible with Poser 11. There is no time frame for 

when we will have this available at this time. I apologize for 

the inconvenience." This didn't sound promising. Considering 

other problems with PP11, I really couldn't see much reason to 

stop using Poser Pro 2014. I did find a couple of procedures 

that can be employed to allow the use of the Genesis/Genesis 2 

figures. 

 

Clunky Procedure: Import the desired item, save the scene, exit 

Poser Pro 11, reload Poser Pro 11, make sure the Poser Library 

is loaded and active, and reload the scene. Load the next 

Genesis item and go through this procedure again for every 

Genesis item that you want in your scene. Even if you want only 

one Genesis item, you must go through this process because, once 

the DSON Importer has done its job, nothing else in the Library 

can be loaded. 

 

Resave Procedure: Another, easier, solution which can often be 

used to avoid the above, Clunky Procedure is the following: Load 

Poser Pro 2014. Load the item which requires the DSON Importer 

into a New scene. Save the item back to the Library that it came 

from - with a new name. I use the old name and end it with 

"Psr", but you can call it whatever you want. For instance, if I 

load Girl 6, I save her back as Girl 6 Psr. Now, if I need Girl 

6 in a PP 11 scene, I load Girl 6 Psr. I can load as many of 

these resaved items as I wish. 

 

CAUTION: Make sure that you save the new file with a new name. 

Otherwise, you will overwrite the original file. My Resave 

Procedure does not work for all items requiring the DSON 

Importer, so don't lose your original file. You may need it and 

the Clunky Procedure to use the item in a scene. 

 

Many (some/all? I don't know) Materials (MATs) and Poses work 

with the resaved figures. If you find some that do not, try some 

of the procedures below. 

 



This Resave Procedure works for many Figures. I think it works 

for many Props. It also works for many Materials (MATs), 

although many MATs (some or all? I don't know) will load just 

fine onto the resaved Figure. However, if you decided to use the 

Resave procedure for a MAT, take note of the Caution which 

follows. 

 

CAUTION: MATs (sometimes found in the Pose Library, sometimes in 

the Materials Library) cannot be loaded into an empty scene like 

a Figure to be resaved. They must be loaded onto a Figure or 

Prop in the scene, and you don't want to load the whole Figure 

and other MATs back to the Library. I haven't done much 

experimenting with this load/save method, so a few gotchas may 

be waiting for the unwary. 

Load a MAT onto your Figure (or Prop.) Note that your Figure may 

already contain some default MATs that you do not want saved 

with the MAT of interest. For instance, if you want to load a 

facial makeup MAT onto a Figure which has different skin tones, 

notice that the Save window - where you will enter the new name 

for the MAT - will also have an option allowing you to choose 

which parts (there may be a lot) of the Figure's MAT you are 

saving. For instance, if you want to resave facial makeup, you 

may discover that you are about to save the MATs for the legs, 

arms, hands, etc., in addition to the parts of the head that you 

want. Uncheck these extra items before you go ahead and save. 

 

I haven't tried saving Pose morphs. I'm guessing working with 

them will be similar to working with MATs. However, at least 

some G2 Poses work fine with the resaved (...Psr) files, so 

there may be no need to resave Poses. 

 

 

 



Grouping 

 

Grouping is an alternative to Parenting objects. 

 

A Grouping Object is a container that acts as a Parent for 2 or 

more objects. I’m not sure what the advantage of Grouping over 

Parenting is, unless Poser won’t let you parent one object to 

another (which I mention in the NOTE at the end of my Parenting 

section.) 

 

To create a Grouping Object: 

 

 1. Object > Create Grouping. A container named Grouping # 

appears as a small wireframe box at the Origin. 

 

 2. Select an object (Figure or Prop) to be placed in the 

Group. 

 

 3. Object > Change Parent 

 

 4. Select the Grouping # from the Object Parent dialog box. 

 

 5. Click OK and repeat for each object to be placed in the 

Group. 

 

 

 

 



 Hair 

 

Unlike clothing, which is usually specific to a particular 

model, hair is pretty much interchangeable among models. 

Sometimes it is even "unisex." 

 

Hair may come as a Figure, Prop, or Skull Cap. Figures and Props 

are pretty straight forward - hairy things that you stick on 

your character's head. Skull Caps are a bit different. See the 

section on Changing the appearance-skull caps below. 

 

Fitting the hair to the head: 

 

Some hair will go to the proper position on the head when 

loaded. If not, you may need to Conform the hair to the head 

(although I usually conform to the Body). 

 

Some hair will move from its default loaded position to the 

correct position on the head when Conformed to a model, but 

conforming does not always work. In this case, you have to 

manually move the hair into position. I've found several hair 

styles that must be scaled to 110% or 120% to get them to fit 

the head of a model. 

 

Attaching the hair to the head: 

 

Some hair is attached to the head by default. Or it may be 

attached when Conformed. Since hair cannot always be Conformed 

to the model, make sure that you Parent the hair to the Body of 

the model. If you don't, the hair will get left behind when you 

pose the model. Also, if you are creating a modified model that 

you want to add to your Library, the hair will be left out of 

the "The figure is a part of a compound figure grouping" step if 

not Parented! Your new figure will end up bald in the Library. 

Sometimes Conforming doesn't attached the hair to the head. 

Check and see what happens when you pose the model. Parenting 

may be necessary. 

 

Changing the appearance-Morphs and MATs: 

 

Some hair styles come with a variety of morphs that can be used 

to change the appearance of the hair. 

 

Most hair styles also come with MAT files to change the color. 

Hair color can also be modified in the Materials room by 

changing the Diffuse and Highlight colors and other settings. 

 

I recently discovered that Neftis hair props (perhaps others) 

require that things be done in a certain order: Load the 



character, load the hair, load the MAT for the desired hair 

color. I'd bought a Kavaro hair while on sale at Renderosity. 

Just to make sure that I'd installed everything, I loaded the 

hair into Poser Pro 2014. All okay. Then I loaded one of Neftis' 

Pose Mats. Nothing happened. I tried again. I tried loading some 

of Neftis's other hair props. Neftis Pose Mats would not load to 

these either. I thought something had gone wrong with my 

installation of Poser. Then, to get a rendered image to use in 

my WordPerfect Library Contents file, I loaded Michael 4 and the 

Kavaro hair in its default color. Just out of curiosity, I tried 

to load one of the Kavaro Pose Mats. It worked! All the Pose 

Mats worked. I tried some of the other Neftis hairs on Michael 

and they all worked with their Pose Mats just as they should. I 

even loaded the Kavaro hair and Prop Mat onto Virginia 6. I 

could even load a Prop Mat to the Kavaro hair after I parented 

the hair to an Avro 504k WWI aircraft figure! Everything worked 

as it should. Fortunately, nothing was wrong with Poser. You 

just have to make sure that you load the Neftis hair onto a 

character before changing the hair color - which should not be 

difficult since that is the normal way to do things anyhow. I 

just think it's an odd property of Neftis hair. 

 

Changing the appearance-skull caps: 

 

Not all hair comes as hairy Figures or Props. Some come as 

"skull caps." The skull cap fits onto the head like a lady's 

bathing cap, and makes the figure seem to have a white bald 

head. As usual for Poser models, which Library the skull cap is 

in depends on who created it. 

 

To give your character hair after loading the skull cap, load 

the "hair style" for the skull cap. This will not be a Figure or 

Prop, but is a Map to be added to the skull cap and uses the 

Bump function to simulate hair. As far as I'm concerned, hair 

done via this method looks about the same as for "real" hair. 

 

One caution: I recently needed a very large figure in a scene. I 

set the scale from 100% to 3000%. This figure was fit with a 

3Dream skull cap and hair. The 3000% figure no longer had her 

wavy hair. I found that if I changed the Bump Amount from 0.07 

to 3.00 she had a wavy head of hair again. 

 

Render time: 

 

Something to be aware of is the long render time that can be 

involved with some hair. I used Poser Pro 2012's "P8 Alyson 

Hair3" on one of my characters. I did a 3072 x 2048 pixel render 

of a scene that she was in. When the render got to the portion 

of the scene that had the hair, I thought that my Poser had 



locked up (Not again!). Rendering that portion of the scene took 

hours. Even smaller renders can take quite a while. Just don't 

be surprised when the process seems to have come to a 

standstill. Just hope that your computer doesn't go into 

hibernation while you're waiting. (I had decided to let mine 

render overnight, and the computer was off when I got up the 

next morning. It was still in the middle of the render when I 

turned the computer on again.) 

 

Hats and Hair: 

 

When you put a hat on your head, your hair gets smooshed down 

and a portion is covered by the hat. This doesn't happen with 3D 

models. Under normal conditions, models don't actually contact 

each other - they penetrate each other. So if you put a hat onto 

a head with any significant amount of hair, the hair will poke 

out through the surface of the hat. As far as I know, Poser has 

no feature to prevent this. Two things can be done to fix this 

problem: 

 

A. Use the Morphing Tool set to Push and push the hair back into 

the hat. Be careful - it's easy to push on hair that is not 

poking through the hat and deform it. 

 

B. I can fix the problem in post-processing with Photoshop. Here 

is what I do: 

 

 1. Create the scene in Poser with the hat and the hair as 

you want them. 

 

 2. Render the image and export it with a name like Hair-On. 

 

 3. Select the Hair and in the Properties menu, uncheck 

Visible. 

 

 4. Render the image and export it with a name like Hair-

Off. 

 

 5. Exit Poser and run Photoshop. 

 

 6. Load both Hair-On and Hair-Off images. 

 

 7. Select All of the Hair-On image and Copy and Paste it to 

the Hair-Off image. (Close Hair-On so you won't get confused and 

work with the wrong image.) 

 

 8. Just in case, save the combined image to Hair.PSD 

 



 9. If necessary, open the Layers Window (Window > Layer). 

Hair-Off is now the Background, Hair-On is Layer 1. Be sure that 

Layer 1 is selected. 

 

 10. Set Opacity to 50% or whatever allows you to see the 

Hat clearly through the Hair. 

 

 11. With the image of the Hat as a guide, erase all Hair 

that is sticking though the surface of the Hat, and any other 

Hair that you wouldn't see if the Hat was doing what a real hat 

does. 

 12. Return the Layer 1 Opacity to 100%. 

 

 13. Select the Layer drop-down menu and click on Flatten 

Image. 

 

 14. Save the image with whatever filename you now want and 

in whatever file format (such as JPG) that you normally use. 

 

 



HDRI 

 

HDRI seems to be a way to provide a spherical background for 

your scene and the lighting that this background, if actually 

there, would provide. Perhaps it's because I don't know enough 

about using HDRI, but I'm not all that taken by it. However, I 

want to include here what I think I know about using HDRI 

assets. 

 

First, download BagginsBill's Environment Sphere file, unzip the 

file and install the prop in the Poser Library (Props > Scenes > 

EnvSphere). 

 

Second, get one or more HDRI sets. All I have now is 

ShaaraMuse's Midsummer Lake from Renderosity. This has 3 scenes 

in 2, 4, 8, and 16K resolutions. I've placed these in a 

Midsummer Lake folder in an HDRI folder. 

 

Open Poser and load the Environment Sphere prop 

 

Go to the Materials Room. In the Panoramic Image node, find and 

select the HDRI image for the Image_Source. I've found that the 

2, 4, and 8 K images give slightly blurry images when rendered. 

The 16K is preferable. 

 

Set Gamma In and Gamma Out nodes to 1.0. Each of these has two 

values, and I've just set the first to 1.0. 

 

Back in the Pose Room, load whatever figures and props belong in 

your scene. You may need to set your Camera's focal length to 

something smaller to get a wider view of the HDRI image. You may 

also need to set the camera's Yon value to something much 

larger, like 5000, especially if you need to increase the scale 

of the Environment Sphere or to move the camera back a long ways 

from your center of interest. 

 

Before you render, go to the Render > Render Settings and set 

Gamma Correction to 1.0. 

 

Render your image. 

 

I thought that HDRI images were supposed to light the scene. If 

I remove my default 3-point lighting, the HDRI image shows up 

but a figure added to the scene is just a silhouette. He is not 

lit by the HDRI image. 

 

 

https://sites.google.com/site/bagginsbill/free-stuff/environment-sphere


 The Hearts of Space 

 

The Hearts of Space comes with one figure: Blanked_Environment. 

Apparently this allows this set to work without the need for the 

Millennium Enivonment after all. In fact, the two merge if used 

together. 

 

This set contains Body Parts named the same as Millennium 

Environment: Terrain, Scenery_Sky, and Clouds_Weather. 

 

A series of Poses contains textures for each Body Part. Terrain 

can have an snow field or a star field. Scenery_Sky can have an 

ice planet, a watery planet, a galaxy and starfield, or 

something (Styx) like a brown dwarf. Some of these come in a 

variety of sizes. Clouds_Weather can have a variety of 

asteroids. 

 

 



 

 Hidden Maps 

 

I wanted to use one of the Alyson hair styles on a Victoria 4 

model. The default hair color is red, but I wanted black hair on 

my model. So I loaded a black hair MAT. 

 

But the hair would not render as black. It came out a dark 

brown. I tried changing the Diffuse color to shades of green in 

an attempt to cancel out the brown. This helped, but didn't 

really work. I checked the Advanced settings to see if I could 

see something besides white or black color blocks. Nothing. I 

spent all afternoon tweaking this, that, and the other settings. 

 

Finally, while rechecking the Advanced settings, I noticed a map 

set to something like Alyson_red.jpg. I changed this to the 

Alyson_black.jpg map for all parts of the hair. I finally had 

black hair! 

 

Apparently, the Alyson_red map was used in the default hair 

settings. Why it did not change when I loaded a different hair 

color, I have no idea. Must be a sort of a bug in Poser Pro 

2014. 

 

I don't know if this is a problem limited to hair colors or not. 

But, should you notice that colors are not as expected from the 

MAT that you loaded, you should check the Advanced settings and 

make sure that all maps used are compatible with the MATs that 

you've loaded. 

 

 



 

Hierarchy Editor 

 

I. Attaching multiple components of a Figure or Prop to a Single 

Component, the new Parent 

 

I have bought a few Props which are not in Poser’s CR2 format. 

They come as OBJ, DAE, or FBX files which must be Imported then 

Saved to the appropriate Library. Unfortunately, some of these 

turn out to be collections of Props with no Parent, which means 

that there is no way to deal with the new Prop as a single 

object. For instance, I can’t select a boat’s hull to move the 

entire boat – the hull is moved and everything else stays 

behind. To solve this, each of the components can be Parented to 

the hull by the technique described in I. above. However, if the 

new Prop contains dozens of components, this is time consuming 

and tedious. It’s easier to use the Hierarchy Editor as follows: 

 

Click on the Windows drop-down menu 

 

Click on Hierarchy Editor 

 

Click on a Child component and Drag it to the desired Parent. 

(It might be best to choose the first item in the list to become 

the Parent.) Drop on the Parent 

 

Repeat for each component until all are Parented 

 

Exit the Hierarchy Editor and Save the Prop to the Library. 

 

II. “Main Frame” Robot problem 

 

While working with Shawnaloroc’s “Main Frame” robot from 

Renderosity, I wanted him to sit in a car with his hands and 

arms posed so that he seemed to be steering the car. The robot 

did come with a Sit pose, but his hands and arms were in his 

lap. The dials provided to Bend or Down-up his shoulder and 

forearm would not work. Changing the Limits Settings did not 

help.  

 

I site-mailed Shawnaloroc about the problem and was advised to 

go to the Hierarchy Editor and uncheck the Hands boxes in the IK 

Chains section for the robot. This worked. I’ve never used the 

Hierarchy Editor before, so here is how to use it: 

 

 1. Window drop-down menu > Hierarchy Editor 

 

 2. Click the down-pointing triangle (▼) at the upper-right 

of the Editor to expand the menu. 



 

 3. Scroll down to the Figure or Prop of interest and find 

the IK Chain list. 

 

 4. Deselect the Box(es) containing the body part(s) of 

interest. 

 

 5. Exit. The dials should now work, although it still may 

be necessary to change Min Limit and Max Limit in the dial’s 

Settings. 

 



Image Persistence 

 

Contrary to popular belief, a computer's (or any) LCD screen can 

suffer from something analogous to a CRT's "Burn-In" or 

"Ghosting" - something that does not move when the screen is 

left on for an extended period can be seen as a ghost image when 

the screen is some uniform, dark color. Click here to jump over 

how I made this discovery and came up with the solution to what 

I will do in the future to avoid it. 

 

I had a complex render that required much more than a half hour 

- or even overnight. It was only a little over half done when 

allowed to render overnight. I did not want to give up my 

computer for a day or more, so I did some experimenting. 

 

I started the image rendering, then Minimized the Poser window. 

When I Restored the window all I could see was white with 

horizontal and vertical dividing lines. The Render progress 

window was black. I was unable to recreate this problem with a 

different render because the window would not minimize while the 

image was being rendered. So I don't know if this was a freak 

occurrence or what. Regardless, minimizing the window does not 

seem like an option. 

 

I found that I could resize the Poser window and place it and 

the Render progress window in a spot on my desktop where it was 

not blocking any icon that I might need. I could then start the 

render and I could use any of my other programs without a 

problem for the render or for the other programs. So I let the 

render go on during the day, let it run overnight, through the 

next day, and overnight again. The next morning the render was 

complete. This was just for the 1401x788 image. I imagine that 

rendering a 1920x1080 image would take much, much longer. 

 

After the render was over, I discovered the problem. On a 

uniformly dark gray (or other color) screen, I could see a ghost 

image of the outline of the resized Poser window that I had 

created, along with a few other divider lines! 

 

According to what I found on the internet, contrary to what was 

supposed to be true for LCD screens, they suffer from something 

analogous to "CRT Burn-In" or "Ghosting" - Image Persistence. 

Suggested cure(s): Sometimes the ghost image would disappear 

just by continuing to use the computer. Sometimes turning the 

computer off for as long as it had been on would fix things 

(Right! Like I can do that.) Sometimes making the screen a 

bright white for a while would fix it. Sometimes using a screen 

saver (to exercise the stuck pixels) would fix it. I've been 



trying a combination of the latter two suggestions. My Desktop 

background is set to white and I've started the Windows "Ribbon" 

screen saver. The screen saver has been running overnight for 

several nights and the ghost has pretty much disappeared. An 

irregular cloudy band with the outline of the tops of some of 

the icons at the top of my Desktop which I noticed months ago 

has also started to smear out a bit. 

 

In the future, if I have any more long, long renders, I will 

resize the Poser window to a size and place on the Desktop where 

it will not interfere with running other programs, let the 

Windows "Ribbon" (or other) screen saver run during the day, 

then turn it off at night (so as not to slow down the render) 

and turn off the computer monitor. My monitor can be turned off 

by pressing the Fn key at the bottom of my keyboard and tapping 

the F2 key. I'll turn the monitor on (tap any key) and the 

screen saver on the next morning so that I can work. Repeat at 

night as needed. NOTE: a different computer may have another way 

to turn off the screen. If the screen cannot be turned off, the 

only alternative would be to let the screen saver run constantly 

and accept any hit to the render speed. 

 



 Importing Models 

See also: New Characters 

 

Although many Poser-compatible models are available, some 

websites offer models which were not meant specifically for 

Poser. For example, models produced with 3D Studio (3DS 

extension), Wavefront (OBJ extension), or COLLADA|RWY (DAE 

extension) software can be imported into Poser and used as 

Props. The following is what I have done: 

 

 1. Download and (probably) unzip the file. 

 

 2. Place the 3DS, OBJ, or COLLADA|RWY and its supporting 

files into a folder (Usually the OBJ folder). 

 

 3. For 3DS or OBJ files: In Poser, File > Import > 3D 

Studio > Import Options: Check Centered, Place on Floor, Percent 

of Standard Figure Size 100%, and Offset 0,0,0 > OK > Browse to 

the desired file and Double Click/Open the file to load it into 

Poser. (Do the same to Import a Wavefront OBJ file) 

 

 4. For DAE files: In Poser, File > Import > COLLADA|RWY > 

Check Import options if desired > Double-Click on the DAE folder 

to load it into Poser. 

 

 5. It may be necessary to browse to the same location and 

select the MATs for the model if the little window looking for 

files opens. 

 

 6. If necessary, go to the Hierarchy Editor and Parent all 

components to some convenient component. 

 

 7. If necessary, Scale the model to the proper Poser size 

 

 8. Open the Props Library and the proper Folder, then 

create a subfolder for the model. For example: Props Library > 

Scenes > create Old House folder for a model of an "Old House." 

Click the + button (Add to Library), give the model a name, and 

click OK to save it to the Library. 

 

The model can now be loaded again when you need it without going 

through the Import process. 

 

I cannot guarantee that all downloaded models will be easy to 

work with. I downloaded and imported a model of Earth and never 

did manage to figure out how to use its maps to give me a 

workable model. It was a freebie, so I got what I paid for. 

 



Kitbashing 

 

Kitbashing is the process of taking pieces of other models and 

combining them to create a new model. 

 

Thousands and thousands of models (some folks prefer the name 

"assets") are available for Poser. But sometimes something 

needed is not available (yet) or is not quite what's needed. 

That's when I resort to kitbashing. 

 

Poser comes with an assortment of "primitives" (and other 

suppliers have other primitives for sale) that can be combined 

to give something new. I used a bunch of resized and rescaled 

Cubes to create the walls and floors of my Marco Pollo starship 

crew quarters. I made all parts but the head of one Victoria 4.2 

model and the arm of another invisible and combined them when I 

created my Heads Up statue. 

 

Once created these new models can be saved to new or existing 

folders in the Library. Props go into the Props Library and 

Figures go into the Figures Library. 

 

What about items which contain both Figures and Props? I 

recently created an Antique Shop for the Pierre Bordeaux 

character who appears in some of my science fiction stories. 

Most of this shop was created from Props with a few Figures. All 

were Parented to one of the Wall Props. I saved the final model 

in my Props Library. 

 

When I loaded the Shop into a new scene that I was creating I 

discovered that all the Figure components had vanished and Props 

that had been part of that figure had moved and resized. I tried 

resaving the Shop from my final PZ3 file, restarting Poser, and 

even shutting down and restarting my computer. Nothing made any 

difference. 

 

On a hunch, I picked a Ladybug Figure from the model, reParented 

it to Universe, Parented the Wall Prop to the Ladybug, and saved 

the modified model to a folder in the Figures Library. Viola! No 

more problem! 

 

In conclusion: To create a model containing both Figures and 

Props, include everything in a Parent hierarchy that has a 

Figure at the top. Then save the model to a folder in the 

Figures Library. 



 Launch to Preferred State 

 

The Document window can be set up any way desired and then when 

the program runs it starts up that way. For example: Delete 

Andy2. Then Edit > General Preferences > Document tab > Launch 

to Preferred State radio button > Set Preferred Scene. Now the 

program opens without needing to have Andy2 deleted. I currently 

have the preferred state to open with these settings: 

 

Use External Binary Morphs = Off (in General Preferences > 

Miscellaneous) 

 

Andy2 deleted 

 

General Preferences > Render > Max Cashed Renders = 5 

 

General Preferences > Document >Max Undo Levels = 20 

 

Ground: Check Visible, uncheck Visible in Ray Tracing and 

Visible in Camera. Check Diplay Origin under the Properties tab. 

This lets me keep track of where the origin and axes are located 

but does not show up in a render. 

 

I tried to have Collisions set to On, but it won't stay On 

 

Libraries: Check Libraries under the Window tab. [[This part 

does not seem to apply to Poser Pro 2014: Click the tiny, almost 

invisible square in the upper right corner of the Libraries 

window, uncheck Drag Docking Enabled, and check Floating.]] 

Resize the Libraries window as desired. Click the View Options 

thingy at the bottom of the window. Click the Display bar and 

check Trees, Item List Panel, and Extended Details. Click the 

Details bar and uncheck Show Image. Close View Options. General 

Preferences > Library > Launch Behavior: External. 

 

Load 3 Point Lighting from the Libraries > Light > Poser Pro 

2012 > Portraits. 

 

Render: Render tab > Render Settings > Select Auto Settings then 

move the little triangle and its line to the notch to Final. 

 

When finished, Edit > General Preferences > Document tab > 

Launch to Preferred State radio button > Set Preferred Scene. 

 

Close and reopen Poser. 



 Library 

 

Poser Content from Previous Versions 

 

Installing a new version of Poser can result in older Poser ## 

Content files from being missing from the new version’s Library. 

These files can probably be found here: 

 

 C: > Users > Public > Public Documents > Poser XX Content > 

 Runtime, where XX is the old version number.  

 

Copy the Runtime folder into the adjacent Poser YY Content 

folder, where YY is the new version number 

 

 

 

 



 

Library Category Problems 

 

The Poser Library consists of 10 categories: Figures, Pose, 

Expressions, Hair, Hands, Props, Light, Camera, Materials, and 

Scene. Unfortunately, some of the folks who create things for 

Poser aren't very careful when they put an item into one of 

these categories. 

 

Figures, to me, means creatures: humans, aliens, plants and 

animals, etc. Props, to me, means anything that you would 

provide for a figure to use or to find in the environment: 

Clothes, weapons, chairs, lamps, etc. But sometimes "props," 

especially clothes, are found in Figures, sometimes in Pose, 

maybe even in Props. This is especially true for Michael 4 and 

Victoria 4.2 from DAZ3D. 

 

The Library category Materials is for files which change the 

color, pattern, or texture of some other item. But Materials 

(MAT) files are apt to be found anywhere. This jumbling means 

that you may not even suspect that certain MAT files exist for 

your Figure or Prop, since when you look in the Materials 

Library, many files are elsewhere. The same is true for poses, 

props, and maybe even figures. New figures are created from 

others with INJ (injection) files (no Library category). You 

might expect to find these in Figures, but they can also be 

found in Pose and Materials. Confusing, no? 

 

I've tried to sort this out by creating my own Library Content 

file. I abandoned the 10 Poser Library categories and came up 

with my own. I've come up with a list of items that I might want 

in a scene: Aircraft, Aliens and Other Humanoid Creatures, 

Animals, Clothes and Uniforms-Male, Clothes and Uniforms-Female, 

Construction Equipment, Fungi, Hair... all the way to 

...Statues, Textures, Weapons. Any of these can have 

subcategories and subsubcategories: Aircraft > Blimps and 

Zeppelins, Jet Pack, Jets... 

 

Under each of these categories and subcategories I place the 

Poser Library path for the item or for other items (props, 

poses, MATs) related to the main item. For instance, my first 

entry under Clothes and Uniforms-Male looks like... 

 

 

 

 

 

 

 



 Armor 

    Ryan 

  Props > Poser Pro 2012 > Clothing > Ryan Clothing >  

   Armor: BLLE-Ryan_arm, BLLE-Ryan_Belt, BLLE- 

   Ryan_Chest, BLLE-Ryan_Helmet, BLLE-Ryan_Leg,  

   BLLE-Ryan_Mask, BLLE-Ryan_Suit, DE731Boots, DE731 

   pants, Helmet, Leg Armor, MechArms, Shoulder  

   Armor 

 

Adding to the Library 

 

 Folders And Subfolders 

 

 Create a new top level folder (such as SEC Characters) 

under a Library category manually, since I haven't found a way 

to do it in Poser: Navigate to C:\00-Data\Poser Pro 

2012\Libraries and create a new folder with the desired name. 

Open the new folder and create a Runtime folder. Note: Others 

users may place their Libraries folder in some other location 

than \00-Data\:Poser Pro 2012.) In Poser, open the Library and 

select Add Library at the top right. Find the new folder and 

select it. The new Library folder will be placed near the bottom 

of the list of folders. 

 

 Subfolders can be created within the Poser Library by 

opening the folder or subfolder where the new subfolder is to be 

located. Click the Create New Folder button at the bottom, give 

the subfolder a name, and click OK. To alphabetize the list 

(manually) see Alphabetizing the Libraries below. 

 

 Figures 

 

 1. After creating the new figure (or at any earlier time) 

go to the Properties tab and change the name from the name of 

the base figure to a name of the new figure (for example, change 

Victoria_4 to Gina.) 

 

 2. Create and name a new folder for the figure in the 

Figures category of the Library as described above. 

 

 3. Load the PZ3 file of the desired figure into Poser. 

 

 4. Select the new folder in the Library and click the Add 

to Library [+] button at the bottom. Give the new figure a name. 

Choose "Whole Group." 

 

 5. New Library files are created in the Runtime folder, 

including a 91 x 91 pix png file for the icon. This is created 

from the image in the preview window and can be replaced by 



another image if desired. It is located in 

...\Runtime\libraries\character 

 

 Materials/Textures 

 

Some sets of purchased Materials/Textures unzip and provide a 

Runtime folder to be copied to the Materials Library. These can 

be accessed with no problems by working down the path to their 

folder. Others unzip to a folder(s) of jpg (or pgn) graphic 

files which must be placed in a folder outside Poser and its 

Library. Using these exterior Materials can be a bit 

inconvenient. 

 

Here's how I get them into the Poser Materials Library: 

 

NOTE: I am using the Main Camera and my 3-Point Lights. 

 

 1. Open Library > Materials > Materials 

 

 2. Click the Add Folder icon > name the new folder with the 

name of the exterior folder > OK 

 

 3. Open Library > Props > Poser 11 Contents > Primitives: 

Square Hi Res > Click on the Square to be sure that it is 

selected. 

 

 4. Rotate the Camera so the Square appears as if x-Rot 90o 

and move close enough so the Square fills most of the Preview 

Window. This results eventually in a nice looking icon in the 

Library. 

 

 5. Go to Materials Room > click on the empty Diffuse Map > 

Browse to the exterior texture folder and double-click on the 

texture file desired > OK 

 

 6. Set the Highlight Color to Black (so the texture won't 

be shiny when applied) 

 

 7. Return to the Pose Room and the texture's icon will have 

appeared in the open Materials subfolder. 

 

NOTE: These exterior folders of textures can hold a lot of 

files, so putting them all into the Library can be a bit time 

consuming. Unless I have nothing better to do, it might be 

better to put just the files into the Library that are apt to be 

used again. 

 



 Props 

 

 1. After creating the new prop (or at any earlier time) go 

to the Properties tab and change the name from the name of the 

base figure (what everything is parented to) to a name of the 

new figure (for example, change Pipe_1 to Potato Pistol) 

 

 2. Create and name a new folder for the figure in the Props 

category of the Library as described above. 

 

 3. Load the PZ3 file of the desired prop into Poser. 

 

 4. Open the Props Library and select the target folder for 

the new prop (For instance: Props > SEC Characters > Potato 

Pistol). 

 

 5. Click on the Add to Library button [+]. (If the Add to 

Library button isn't there, close the Library and Poser and 

reopen them. Pick up the process here at Step 3.) Give the new 

prop a name (like Potato Pistol). Don't click OK yet! 

 

 6. Since the new prop is probably made of several component 

props, click Select Subset and select all the parts that make up 

the new prop. Then click OK. The new prop should appear in the 

new folder. 

 

 Scenes 

 

Some time ago, I decided that I wanted to create the Crew Cabin 

for my Marco Pollo starship - that is, the bridge, galley, head, 

crew quarters, etc. I used Poser primitives to create the walls, 

floor, ceiling and doors. I populated the rooms with lights and 

items appropriate to each. Eventually I had a PZ3 file of the 

Crew Cabin (7 rooms) and its contents that I could utilize if I 

wanted to create an image onboard the Marco Pollo. 

Unfortunately, Poser has to consider all the "stuff" in the file 

even if only a single room is to be in the final render. This 

makes operations like moving the camera very slow. 

 

I decided to create separate PZ3 files for each room. I deleted 

everything but the desired room, its lights, and its contents 

and saved the result as a separate file. Now all I had to do 

was, for example, to load CrewQuarters1.PZ3 if I wanted a scene 

in the Captain's Quarters. 

 

If necessary, I could make walls and doors invisible to get good 

views of the interior of a room. Unfortunately, if I wanted a 

shot from behind someone standing in a doorway looking into the 

Captain's Quarters (or from the inside looking out), then the 



hallway around the character was missing. I could have the 

hallway in the scene, or the room, but not both unless I used my 

large Crew Cabin file. I'm not aware of a way (maybe there is 

one) to combine two different PZ3 files into one. What I needed 

were Library files that could be loaded just like characters and 

props. 

 

I'll describe what I did. Perhaps some day I'll discover an 

easier (proper?) way to do it. 

 

First, I loaded the PZ3 file of the room that I wanted to work 

with. 

 

Next, I added a Poser Pro Left Hand Figure (any figure would do) 

to the scene to be my "Main Parent". (For this particular 

figure, I had to rescale it from 1000% to 100%.) I posed the 

hand under the floor, out of sight. I changed the name of the 

hand from "Figure" to the name of the room. For instance, 

"Figure" >>> "Galley". Then I parented every other figure in the 

room to the Main Parent-Body (Galley-Body) via the Figure drop-

down menu and every prop in the scene to the Main Parent-Body 

via the Object drop-down menu. I checked that I hadn't missed 

anything by selecting the Main Parent Body and increasing or 

decreasing the scale. If everything rescaled, then I'd parented 

everything correctly. Now if I need to move the room, I select 

the Main Parent-Body and change its x, y, and z coordinates. 

Other items in the scene can be selected and moved within the 

scene as desired. 

 

Once everything had been correctly parented, I created a folder 

in the Library (in this case, Figures\Spacecraft\Marco Pollo 

Crew Cabin) with the Create New Folder button at the bottom of 

the Library window. 

 

Next, I made sure that this folder and the Main Parent-Body were 

selected. Then I clicked the Add to Library button at the bottom 

of the Library window. I named the room (Galley, etc.) and 

clicked OK, then clicked select the Whole Group (if asked). The 

scene was saved, ready to use, into the Library. 

 

Alphabetizing the Libraries 

 

When I create a new Library folder and add it to the Library 

Window, it ends up at the end of the list. After a while, it 

becomes difficult to find a Library because they are not in 

alphabetical order. Poser does not have a function which allows 

the Library to be alphabetized. However, John at Poser Tech 

Support told me how to do it manually: 

 



 1. Find the file LibraryPrefs.xml on your hard drive. I 

created a shortcut, Poser for alphabetizing Library, to the 

\Poser\ folder in my path to LibraryPrefs.xml so that it will be 

easier to find the next time I need to alphabetize the folders. 

On my computer, the path is 

C:\Users\jackw\AppData\Roaming\Poser\13\LibraryPrefs.xml.     

For Poser Pro 12, 11, 10, or PP 2014 the path is similar. You'll 

have to substitute your user account name where I have jackw. 

 

 2. Right-Click on LibraryPrefs.xml. Click on Open With and 

select Notepad. 

 

 3. Save the file with a modified name (I used 

modLibraryPrefs.xml) to protect my original file. 

 

 4. Manually cut and paste entire lines to get each Library 

Folder in alphabetical order. 

 

 5. When done, go back to each line and renumber the index= 

"#" so that each line is in correct numerical order. 

 

 6. Save the modified file, modLibraryPrefs.xml, and exit 

Notepad. 

 

 7. Backup or rename the original LibraryPrefs.xml file (I 

renamed mine buLibraryPrefs.xml) in case your modified file 

isn't quite right. 

 

 8. Rename your modified file: modLibraryPrefs.xml becomes 

LibraryPrefs.xml 

 

 9. If you did everything right, your Poser Library Folders 

should be in alphabetical order. If not, go back to Notepad and 

fix whatever is wrong. 

 

Favorites 

 

When the Poser Library is opened, 3 tabs are at the top: 

Library, Search, Favorites. Library is the normally used listing 

of all items in Poser's Library. Search finds items from Library 

categories that you select. Favorites is empty until items are 

placed into it. Favorites allows you to place items that you use 

often in a convenient place so that you don't have to search 

through the Library for them. It's like having a Shortcut for 

something. 

 

To place an item into the Poser Pro 11 Favorites: 

 

 1. Select the item from the Library. 



 2. Click the star (★ - Add to Favorites) button at the 
bottom of the Library window. 

 

 3. If there is no existing folder for the item, click on 

New Folder Name > type in a folder name > OK > OK and the item 

is placed into the new folder. 

 

 4. If you want to place an item into an existing folder, 

click on the desired folder > OK. 

 

Placing an item into the Poser Pro 2014 Favorites is probably 

similar. I figured out how to do it a while back, but didn't 

write it down and I haven't done it in a while. 

 

Missing/Bad Icons 

 

I occasionally find that an asset in the Poser Library has no 

useful icons - just a gray icon with an outline of a turtle, or 

maybe it's someone shrugging their shoulders and saying "Beats 

me!" In the past, I haven't thought much about it. I just relied 

on the caption to make my choices--Paint Brush is pretty 

obvious. However, I installed something with 30 poses plus their 

mirrors. Imagine trying to make a choice from just captions like 

Pose01, Pose02, Pose03...Pose30. A little investigation showed 

that the icon files for the poses were not missing, but in RSR 

format, which apparently cannot be read by any Poser version 

since 7. 

 

You may have a similar problem if you save something to the 

Library. Poser automatically creates icons for things saveed to 

the Library. However, it creates them from the Preview window, 

not from a Render image. This not normally a problem, but 

sometimes the Preview image is radically different from the 

Rendered image. For instance, the Kids 4 character, Lei, 

Previews as Black although it Renders to a normal skin tone. 

Saving such a character to the Library gives an icon with black 

skin. 

 

Here's what to do if you'd like to create your own readable or 

realistic icons: 

 
 1. Find the computer's path to the folder holding the asset 

with the missing/bad icons. In the case of the missing icons 

described above, the path was something like C: > 00-Data > 

Poser Pro > Libraries > Victoria_4_2 > Runtime > libraries > 

Pose > 30V4Poses > Pose01.ps2, Pose01.rsr, etc. Pose assets have 

a ps2 file extension. Other types of assets have different 

extensions: fc2, cr2, etc. Modern Poser icons have a PNG 

extension instead of RSR. 



 2. Set the Render Dimensions to 91x91. Actually, any square 

will work--I used 100x100, but 91x91 is the normal size for the 

icons. Poser will resize them to what it wants. 

 3. For the “missing” icons: 

  A. Load whatever you need to have in the Preview 

Window in order to use the assets with the missing icons. In the 

example, that was Victoria 4.2. 

  B. Open the Poser Library folder with the missing 

icons. 

  C. Load the asset (like Pose01) that you want the icon 

for and, if necessary make adjustments in the Preview Window to 

give a nice image. 

 4. For the “Bad” icon: Load the Figure or Prop and any MATs 

desired 

 5. Render the image. Don't be surprised when the rendered 

image is fairly small. Remember, you gave it small Render 

Dimensions. 

 6. File > Export > Image and browse to the location with 

your "Missing/Bad" icon and give it the name corresponding to 

the asset just loaded: If you loaded Pose01, name it Pose01, if 

you loaded Lei, name it Lei. Save it in the PNG extension. 

 

Now if you click the tiny Reload Library icon (double arrows) at 

the bottom right of your Library window, or reload Poser, your 

new icons will be there, ready for use. 



Lights 

 

Ambient Lighting: Making something a Light Source 

 

The other parts of this section on Lights deals with the lights 

that are a normal part of Poser. This section talks about how to 

get some object in the scene to give off light. 

 

In the Materials Room, change the Ambient color from Black to 

White or some other desired color. A map can be added if 

desired. Change Ambient_Value to increase the intensity of the 

light. 

 

These changes will have no effect unless Indirect Lighting (IDL) 

is turned on. To turn this on, go to the Render Tab > Render 

Settings > Firefly (I don't use Superfly. And I couldn't find a 

setting for Indirect Lighting there anyway.) > Manual Settings:  

check the Indirect Light box. Go back to Auto Settings and move 

the slider to the desired position if other adjustments for 

rendering are needed. 

 

Click Render. Note: Before the image renders, Firefly first must 

"Precalculate Indirect Light," a process that can be seen in the 

Preview window as the appearance of red pixels and can take a 

long time to complete (depending on how high the quality of the 

render is set and what is in the environment.) But at least the 

object is now a light source. Unfortunately, this light may not 

do a very good job of illuminating its environment. 

 

3-Point Lighting System 

 

This setup is more or less like the suggestions in Tutorials 3.2 

to 3.4 in Practical Poser 8: The Official Guide. 

 

Light 4 is deleted. Lights 1, 2, and 3 are set to Key, Fill and 

Back (in their Properties tab) with the following settings: 

 

 Light R:G:B Type  Intensity xTrans yTrans zTrans  

 Key   1:1:1 point 100%       30     10     50 

 Fill  1:1:1 point 50%       -30   10     50 

 Back  1:1:1 point 50%        0      10    -50 

 

For Point Lights, I can't see that Rotations make any 

difference. I have not modified it in my 3_Point Lighting 

System. 

Changing the scale of point lights can be helpful if you want to 

find them in order to move them about. I'd suggest changing 

their scale to 500% or 1000%. I may be wrong, but I can't see 



any difference in illumination or shadows in a rendered scene if 

I do this. 

 

If I want to move lights, I generally use the Top Camera, pull 

away until I can see the lights, and then drag them to desired X 

and Z positions. Unfortunately, the default 100% scales tends to 

leave the lights as tiny circles that may be almost impossible 

to find. Scaling them up makes them much easier to find, 

especially if you select the one you're interested in, because 

its icon tends to turn red. I usually change the Y position with 

its Properties Dial while viewing the scene with whatever camera 

I'm using for the scene. I watch for the position of shadows and 

amounts of illumination on objects in the scene. 

 

The Key Light Map in Materials was set to None. 

 

Saving a Lighting System 

 

Saving a lighting system is described in Tutorial 3.5 in 

Practical Poser 8: The Official Guide. Set up the lighting 

system as desired, delete the figure, and reset everything back 

to "normal." Then do the following: 

 

Open the Library > Light. If you want your folder to appear in a 

subfolder, select this subfolder (I chose Light > Scene.) Click 

the Add Folder button and give it a name. This new folder now 

appears along with the others. Click on the folder to highlight 

it. Click the Add to Library button and Name it (I chose 3 Point 

Lighting.) Click the Select Subset button. I selected the three 

lights from the list (but you could select only the ones that 

you wanted if you were making some other setup) > OK > OK. 

Select Single Frame > OK. The new setup can now be selected from 

the Library any time it is desired. 

 

Ambient Occlusion (AO) 

 

Ambient Occlusion (AO) is a measure of the amount of ambient 

light on the surface of some point on an object. It simulates a 

dome of light surrounding the scene and causes shadows to be 

deeper at render time. Render time is increased, but is an 

alternative to using many lights. 

 

 

 

 



 

Image Based Light (IBL) 

 

An Image Based Light (IBL) simulates many colors in a single 

light to make it seem as if the object is within the scene in 

the map associated with the light. 

 

Point At 

 

As a starting point, lights are pointed as follows: Key and 

Fill: right eye, Back: head. This is done by selecting the 

desired light, then Object > Point At... > select the target 

from the list. 

 

 

Spot Light Problem 

 

I have noticed a reddish "shadow" in figures illuminated by a 

spotlight created from Light 1. Going to Materials for this 

light shows that it has a Map, OfficeFoyerBG_512.jpg. Apparently 

this light has been set up as an Image Based Light (IBL). I have 

no idea why. It looks like we're looking into an oval mirror at 

an exterior view of a bridge or something. Setting the Map to 

None gets rid of the problem. 

 



 Limits 

 

I recently discovered what Poser refers to as Limits. 

 

An aquarium prop which I purchased contained several fish props. 

While experimenting, I found that the fish could only be moved 

in 2 dimensions. Which 2 depended on which fish was selected. 

And the fish could not be moved out of the aquarium along either 

of the 2 allowed axes. 

 

Normally, I could go to the Properties tab and, for example, in 

the Translation section, I could rotate the zTranslate wheel or 

change the Numerical Value to its right to whatever value I 

wanted. The same is true for values in the Rotation or Scale 

sections. But for some of my fish, the zTranslate value could 

not be changed. And the xTranslate and yTranslate values could 

not be changed beyond certain values. That's how I discovered 

"Limits." 

 

Just to the right of the Numerical Value settings in each 

Properties section is a little triangle (▸). Clicking on one of 
these triangles opens a window with several options. 

 

Clicking on Settings opens a Parameter Settings window. I have 

not bothered to check out what happens when different values are 

entered into each location. But Min Limit and Max Limit allows 

you to set how much change you can set in the Properties tab if 

you also check the box for Force Limits. For example, if you've  

set Min Limit = -10 and Max Limit = 15 for xTranslate, you can 

no longer move the selected object more than -10 or +15 units 

along the x-axis. 

 

For the fish in the aquarium, I guess the limits set kept them 

from being moved outside the aquarium. For a human figure, 

setting limits could prevent a limb from being posed in some 

unnatural position. A human shoulder, for example, won't really 

rotate through 360o. 

 

I don't imagine that I'll have much use for setting or changing 

Limits, but now I can move a fish anywhere inside or outside the 

tank that I want. 

 



 Material Room - Changing Diffuse Colors 

 

Most of my use of the Material Room has been to change the 

Diffuse color of models so that the surface color of an object 

(or the selected part of an object) can be set to whatever is 

desirable. For instance, a white shirt can be made green by 

changing the Diffuse color to green. 

 

All shirts aren't white. Neither are many other things for which 

you might like to change the color. Sometimes the color is 

created by the color in the Diffuse Map. Changing just the 

Diffuse color results in a combined color, which may or may not 

be what you want. If you want your item to be the pure color 

that you select, you need to get rid of the Diffuse Map. This 

can be done in either of two ways: 

 

 1) Set the Map Strength to 0%. Now the color is determined 

only by the Diffuse color that you choose. However, in the 

preview window the item will look black until rendered. This may 

make no difference to you, but sometimes a black object may be 

more difficult to pose. Black fingers resting on a black thigh, 

for example. Method 2), next, is a bit more involved, but avoids 

this problem. 

 

 2) Click on the Map. This opens a Texture Manager window. 

Click on the Map file name (just above the Browse button). Click 

on None at the top of the list which is displayed. Click OK. Now 

you can choose whatever Diffuse color you want and you can see 

it in the Preview Window. Caution: If there is any chance of 

changing your mind and you might want the map back, write down 

its name. Then you can follow the same procedure as for finding 

the None. Find the file in the list and click on it. 

 

The Diffuse color can be set in either the Simple tab or the 

Advanced tab. In the Advanced tab, the Poser Surface root node 

allows the Diffuse color and many other setting to be changed. 

 

Poser Pro 11 has changed the contents of the Advanced tab to 

take advantage of the SuperFly renderer. A second root node, 

Physical Surface, can be created and used to set the Diffuse 

color and other variables. 

 

Both of these nodes now contain check boxes for FireFly and 

SuperFly. The node settings are sent to the renderer checked. 

The same renderer cannot be checked in both nodes. If either 

renderer box is checked in the Physical Surface node, the 

functions of the Simple tab are disabled. So if you discover 

that you can't set Diffuse to a desired color in the Simple tab, 

go into the Advanced tab to make the desired changes. 



 Materials Room - Changing Diffuse Maps 

 

I sometimes find it necessary to add or change a Diffuse Map.  

 

To remove an item's Map, go to the Material Room - Simple and 

click on the Map. This opens a Texture Manager window. Click on 

the Map file name (just above the Browse button). Click on None 

at the top of the list which is displayed. Click OK. The Map is 

gone. (Something similar can be done to remove any of the other 

maps.) 

 

I have been wanting a dirt road prop but have been unable to 

find one, so I've been experimenting with creating my own by 

adding something from the Materials Library or a JPG texture to 

a Primitive. What follows is a summery of what've learned from 

these attempts. Items mentioned are simply given as examples of 

what I did. Note that these experiments deal only with a 2-

dimensional prop. I haven't done any experimenting with a 3-D 

object yet. I did these tests with Poser Pro 2014, but I presume 

similar results would be had with other versions. Here goes... 

 

Load Props > Poser Pro 2014 Contents > Primitives: Square Hi-Res 

(I haven't tried something other than a square. This may take a 

bit more experimentation, but the procedure is probably 

similar.) 

 

Test 01 - Adding something from the Material Library 

 

Load Materials > Poser Pro 2014 Contents > Basic Materials > 

Stones: Rock 2 (the Material) 

 

 A. To start... 

 

 In the Material Room: 

 

Advanced: Fractal_Sum x = y = z = 1.0 or other desired 

value (let's call it K) to get the Material pattern to the 

size that you want. 

 

If the Material's pattern needs to be larger or smaller, 

increasing or decreasing these values equally changes the 

size of the pattern. 

 

I am not sure why z needs to be set, too, since this is a 

2-dimensional surface, not 3, but it does. 

 

B. Changing the square into a rectangle... 

 



Set xScale = 400% (an arbitrary choice to see how this 

works) 

 In the Material Room: 

 

 Advanced: Fractal_Sum x = .25, y = z = 1.0 or K 

 

Note: Start with Advanced: Fractal_Sum x = y = z = 1.0 or 

K, then divide these values by the same factor as used to 

multiply the x or y Scales to keep the image undistorted 

(in this example, 4 to get 400% and 0.25 for the x 

dimension) 

 

 Test 02 - Adding a Diffuse Texture Map 

 

 A. To start... 

 

 In the Material Room: 

 

Simple: Click on Diffuse Map and Browse to 00-Data > Poser 

Pro 2012 > textures > Flink's Ground: Ground1.jpg 

 

 Advanced: Image Map U_ and V_Scale = 1.0 or K 

 

B. Changing the square into a rectangle... 

 

 Set xScale = 400% 

 

 In the Material Room: 

 

 Advanced: Image Map U_Scale = 0.25, V_Scale = 1.0 

 

Note 1: Start with Advanced: Image Map U_ and V_Scale = 1.0 

or K, then divide these values by the same factor as used 

to multiply the x or y Scales to keep the image undistorted 

(in this example, 4 to get 400% and 0.25 for the x 

dimension) 

 

 Note 2: U ≈ x and V ≈ y 

 

 



Materials - Save 
 

Materials (MATs) are sometimes found in either or both of two 

Libraries - Pose (and are referred to as Pose MATs) or 

Materials. According to a Renderosity Forum page I found on the 

web, this is because early versions of Poser did not have a 

Materials Library and MATs could only be placed in Pose. More 

recent versions prefer MATs be put in the Materials Library, but 

to maintain backward compatibility, creators may also still (or 

only) put MATs into Pose. 

 

Going into the Materials Room and changing the colors of some 

item is easy to do. Should you think you might want to use this 

altered item in the future you could save the entire altered 

item to its appropriate library (which is what I’ve done until 

now) or just save the MAT to the Materials Library. If you have 

an early version of Poser that has no Materials Library, I 

assume (You know what that means!) that you could save a Pose 

MAT. 

 

Here's how to save a MAT: 

 

 1. If necessary, go to the Materials Library and create the 

appropriate Folder or path of Folders. Otherwise, just open the 

appropriate Folder. 

 

 2. Select the altered Prop or Body of the altered Figure. 

 

 3. Get a close up view of the altered item because this 

will be placed in the Library with its new name as its icon. 

 

 4. Click on the Save to Library + at the bottom left of the 

Library. 

 

 5. Enter the new MAT name at Set Name > select Material 

Collection > Select Materials > Select All if it’s not already 

the default) > OK > OK.  

 

 

 



 

Metals 
 

Bronze 

 

I selected the Diana the Huntress statue's base (RoundCube_1) 

and loaded Materials > Real Metals > DzFire > RealMetals > 

RayTraceReflections > Bronze Old. 

 

 I found the values in Materials > Advanced from PoserSurface > 

Reflection_Color were RGB = 140, 119, 82 in the color picker. 

 

In Materials > Advanced I changed Reflect > Background color to 

the above colors with the color picker and set Lum = 150. I set 

Reflection > Background to the same RGB values and set Lum = 50. 

 

I then selected each node of the Advanced tab with CTRL-Left 

Click. I then went to the Materials of every other part of the 

Diana statue, clicked on the PoserSurface node and copied the 

RoundCube_1 values by Right-Click > Paste (CTRL-V wouldn't 

work). 

 

The render looks pretty good. However the skin of the statue 

seemed lumpy. Removing the bump map gave a smooth skin, but 

introduced something that seemed to be a reflection, but I'm not 

sure what it was reflecting. So I put the map back and went to 

Materials > Simple and changed the Amount for the bump map from 

0.005 to 0.001. The skin was still smooth and the "reflection" 

was gone. 

 

A similar procedure should work for other items that need to be 

bronze. 

 

Gold 

 

See Also Below - Gold or Silver Materials 

 

I used my Michael 4/Zetian as the target to make a metallic gold 

and chose his 2_SkinTorso material to alter first. I followed 

the procedure in Mirror below, but stopped before copying the 

Material nodes to all other parts of the Zetian's skin. 

 

I made these modification: 

 

PoserSurface Diffuse_Color and Specular_Color > dark red (Row 5 

column 1), although I'm not sure this makes much difference. 

 

PoserSurface > Reflection_Color and Reflect > Background to 

yellow (row 2 column 2) with the color picker and set Green to 



240 from 255 to give what I think is a more golden color in test 

renders. 

Reflect node Softness = 4 (was 0). This reduces the reflections 

so the surface still looks metallic, but is not a complete 

mirror of the surroundings. 

 

The render looks pretty good, so I copied all the Advanced nodes 

to all other skin, lips, and nails for the Zetian. 

 

Because the Zetian is a reptile with scales, I went to the 

Material Room > Simple tab. I checked Displacement under Bump 

and set Amount = 0.05 for the skins of the face, neck, head, 

hands, and feet. I set Amount = 0.06 for the legs, arm, torso, 

etc. This makes the Zetian's scales a bit more prominent. The 

render looks good. 

 

Gold or Silver Materials 

 

 Open Libraries > Materials > Poser Pro 2012 > Clothing > 

Alyson Clothing > Jewelry: Metal Gold or Metal Silver 

 

 From the Pose Window: Double click on the metal desired  

from the Library window, then select the material you want to 

apply it to from the box that opens. Click OK. 

 

 From the Materials Window: Select the material you want to 

apply the metal to, then double click on the desired metal from 

the Library window. 

 



 Millennium Environment 

 

While looking for a galaxy figure at DAZ 3D I found The Hearts 

of Space (see below). However, the ad said this required 

Millennium Environment, so I got both. 

 

Millennium Environment consists of 4 figures: Environment (trees 

and bushes), Riverside (trees and bushes with a "river"), 

Environment_Tall (blank, I don't know what this is for yet), and 

Back Walls (blank, I don't know what this is for either.) 

 

Environment consists of 3 "Body Parts": Terrain (a grassy 

floor), Scenery_Sky (a background wall of sky and scenery), and 

Clouds_Weather (a wall just in front of the Scenery_Sky wall 

with some clouds and fog.) 

 

Riverside consists of 3 "Body Parts": Terrain (a grassy floor 

and a "river"), Scenery_Sky (a background wall of sky and 

scenery), and Clouds_Weather (a wall just in front of the 

Scenery_Sky wall with some clouds and fog.) 

 

Both are accompanied by an assortment of props: 7 bunches of 

plants, 3 tree trunks, a Sky Dome, and a Water. 

 



Mirroring Content 

 

Sometimes a mirror image of some Poser content is desired. 

Renderosity has a program, Content Mirror by Dimension3D for 

$14.80 which will create this for you. They have a Manual 

downloadable from their Renderosity page. I've only needed 

Figures and Props mirrored. Here is how I do it: 

 

 1. Run ContentMirror.exe 

 

 2. Click OK 

 

 3. Click the [O] box at the right end of the Source File 

Window 

 

 4. Work through the Library path to the content to be 

mirrored 

 

 5. Double-click on the content's Filename 

 

 6. The path to the content appears in the Source File 

Window 

 

 7. Click the Create button at the top left 

 

 8. Filename_Mirror is created and can be found in the 

Library folder with the original. 

 

 9. The _Mirror to be appended to the file name can be 

changed in the Options window. 

 

 10. A mirrored icon can be produced if the Mirror PNG 

Thunbs option is checked. 

 

 

 

 



 Mirrors 

 

I. Making a mirrored surface 

 

While searching for a way to make my Zetian figure a metallic 

gold, I found an online tutorial for creating a mirror at 

wikiHow. I modified this procedure as noted above in Metallic 

Gold. 

 

For a mirror to look like a mirror, it must have something to 

reflect. So I took my Zetian figure, added Millennium 

Environment to the scene, and moved him toward the back, among 

the trees and bushes. Then I followed the directions in "How to 

Make a Mirror in Poser: 24 Steps (with pictures)": 

 

[NOTE: I no longer have to follow the procedure below. For more 

info, please go to Part II] 

 

Select the figure. 

 

Material Room > Advanced Tab. Make sure Object and Material are 

set to the targets that you want to make mirror. Be especially 

careful to check Material before you start. Something like 

Michael 4/Zetian has a lot of Materials and it tends to switch 

to the first thing in the drop down list of Materials every time 

you do a render or change the page. 

 

You will have to eventually go through this procedure for every 

item in the Material list that you want to make a mirror. 

Actually, this isn't as bad as it sounds. I found that I can 

CTRL-click on each of the "nodes"(including those that you must 

scroll to see), then copy (CTRL-V) to each material that I want 

to make into a mirror. 

 

According to wikiHow, the Diffuse_Color and Specular_Color can 

be any color (to make the mirror look more like a metallic 

surface) but for a mirror, black or white are best. 

 

Left-click on the plug icon next to "Reflection_Color" and drag 

to the right to create a new shader node. In the pop-up menu New 

node > Lighting > Ray Trace > Reflect. This creates a new box, 

Reflect. 

 

On the Reflect node, set the following: Background > white, 

Quality = 0.2, Softness = 0, RayBias = 0.002907. 

 

On the PoserSurface node, set the following: Reflection color > 

white, Diffuse_Color > black, Diffuse_Value = 0 (the mirror has 

no color), Specular_Color > black, Specular_Value = 0 (the 



mirror has no sheen or highlighting), Highlight_Size = 0.05, 

Reflection_Color > white, Reflection_Value = 1. 

 

NOTE: In any Preview window, the figure looks drastically 

different than it will after rendering. Right now it looks 

black, and it will not change as other parameters are changed. 

It will only look "right" when rendered. 

 

Pose Room > Properties: Make sure the first 4 property boxes are 

checked so the target can be seen. 

 

Render > Render Settings > Auto Settings, Drag the slider from 

left to right until the "Raytracing" box becomes checked and 

Raytracing bounces = 3. Click Save Settings. 

 

Render the scene to see how it looks. 

 

If the target mirrors its surroundings, go back to Materials 

Room > Advanced. Find the Material that was just changed into a 

mirror. CTRL-click on each of the "nodes"(including those that 

you must scroll to see), then copy (CTRL-V) to each material 

that you want to make into a mirror. 

 

Render again to make sure no part of your figure was missed. 

 

II. Mirror MAT 

 

As I mentioned above, I no longer have to go through this 

procedure to produce a mirror. At least two of my purchased 

models have functioning mirrors (not all "mirrors" produce 

reflections.) However, out of curiosity, I did a search of 

Renderosity for "mirror" and as I browsed the results, I came 

across a product - "Magic Mirror - Real Raytraced Reflections 

for Poser 5 and 6" by ShadowDaleCreations.  

 

The product contains MAT files for one mirror and over 100 other 

reflective surfaces. The set was on sale for $6.50. It was also 

marked "Clearance" and I was only charged $4.50. Because it was 

marked "Clearance," I don't know how much longer it will be 

available, but there are probably other similar products 

available. 

 

The ad said it was for Poser 5 and 6, but it works fine with my 

Poser Pro 11. Just make sure that Raytracing is turned on in 

Render Settings. And don't forget that the mirror looks black in 

the Preview window. 

 

 

 



III. Preventing a Reflection. 

 

Another product, "Mirror, Mirror," by awycoff provided a hint to 

use if you want to have a vampire or something else that does 

not show up in a mirror: Uncheck "Visible in Raytracing" in the 

object's Properties tab. 

 

 

 



 Morphs++ Optional 

 

Morphs++ is a group of Morphs to be used with Michael 4 or 

Victoria 4. These morphs provide Properties dials to change head 

or body appearance or to provide poses. Morphs++ may be optional 

or required. This section deals with use of the Morphs++ Option. 

 

Optional head and body morphs and poses are found as follows: 

 

Pose > Michael_4 > DAZ's Michael 4 > Morph Injections > 

Morphs++ (folder) > Head or Body folders. Head > 1_Full 

Head & Face has 10 named characters, 1 "old" face, and 

other properties or expressions for the face. Body > body 

morphs and poses. 

 

Pose > Victoria_4_2 > DAZ's Victoria 4 > Morph Injections > 

Morphs++ folder: 11 named female faces, 1 "old" face, plus 

318 other morphs for other  body parts (including 

expressions and poses) 

 

Note that these morphs are found in the Morphs++ folder. 

 

To use, load Michael or Victoria, select Body, inject the 

morphs++ desired. You won't see any changes. You need to use the 

Properties Dials for the body part that you want to change. 

 

For example, if you have selected a named character face for 

Michael: Select Head and go to the Property dials: Morphs|Shapes 

> Morphs++ > 1_Full Head & Face: Set the dial for the character 

to 1.0 (or increase from 0 to get a partial morph.) 

 

Do something similar for other body parts or for Victoria. 

Sometimes it takes a bit of hunting through the dial headings to 

find the desired dials. 

 



 Morphs++ Required 

 

Morphs++ is a group of Pose Morphs to be used with Michael 4 or 

Victoria 4. These morphs provide Properties dials to change head 

or body appearance or to provide poses. For some character INJ 

files the ad or ReadMe file states that Morphs++ is required. 

This section deals with use of the required Morphs++. 

 

When you are told that a character INJ requires Morphs++, do not 

go to the Morphs++ folder. Stop at the Morph Injections folder. 

In this folder you will see the Morphs++ folder, some other 

folders, and some INJ or REM files, including an INJ Morphs++ 

file. This is the file to load when a character requires 

Morphs++. 

 

Morphs++ is used only to provide Properties dials that the INJ 

file uses to change the head or body appearance of your new 

character, so if the INJ Morphs++ file is not loaded, your new 

character will not look as you expected! Let me illustrate the 

conversion of Michael 4 (with Rievel hair) to Silverwind3D's 

SoJoon character: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SoJoon is supposed to be a Korean character, but this looks more 

like Marty Feldman. Now, lets add Morphs++ (next page) 

 

NOTE: Sometimes Morphs++ only add Properties dials--the face 

looks no different, so, apparently, sometimes "required" use of 

Morphs++ is actually just an option. I don't know why this is. 

Michael 4 - Default Michael + INJ SoJoon Head 

What the...? 

  



 

 
The SoJoon ad and ReadMe file both stated that INJ Muscle and 

INJ Elite were also required, but unless you want to modify the 

character's body, they aren't really needed (I may find out 

differently some day.) 

 

Morphs++ can be added to M4 or V4 before or after your new 

Character INJ file is loaded. This allows you to check to see if 

Morphs++ are really required or not (in case you're curious.) If 

the Character INJ changes the head before adding Morphs++, then 

Morphs++ may not be needed. To be sure, go ahead and load 

Morphs++. If you see no further change, then Morphs++ was 

actually optional. If you see more changes, then it was 

required. 

 

NOTE: Some Character INJ files loaded before Morphs++ seem to 

make no change in the face, except that the eyes look up. This 

is a hint that Morphs++ is indeed required. 

 

 

 
M4 + Sojoon Head INJ after  

loading INJ Morphs++ 

 
Sojoon with skin textures 



 Motion Blur 

 

Perhaps I didn't look hard enough, but I could find nothing 

about Motion Blur in the Poser PDF Manual's Index. The procedure 

described below is based on Jay Versluis' "How to Use Motion 

Blur in Poser" web page (www.versluis.com/2014/11/motion-blur-

in-poser/). 

 

In Render Settings, check the 3D Motion Blur box then Save 

Settings 

 

Open Window > Animation Palette 

 

Enter 2 in the Frame counter window 

 

In the Frame 2 column, select each item to be blurred and make 

whatever changes in position you'd like to have. In my Biker 

picture, I rotated the wheels 45o and moved the building and 

street a "few feet". 

 

Enter 1 in the Frame counter window and Render the scene. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If this doesn't look good, go back to Frame 2 and select items 

to change. 

 

NOTE: Things that aren't moved along lines parallel to the axes 

are a bit tricky! 

 
No Motion Blur 

 
With Motion Blur 



New Characters 

See also - Importing Models 

 
 A variety of characters come with Poser, but new characters 

can be purchased from sites like Renderosity or DAZ 3D. Three 

types of new characters are available: 1) Truly new characters 

which load into the Library as Figures. 2) New characters 

created by Pose morphs from old characters. These load into the 

Pose Library as INJ files. Load the base character (such as 

Victoria 4.2) then load the INJ files (such as Head INJ and Body 

INJ) and accompanying MAT files. Voila, you have a new 

character. 3) "New" characters created by changing the values of 

certain Properties Dials.  

 

I have noticed two problems with this second type of character: 

 
 A. Body measurements may be significantly different than 

for the original character. So clothes do not conform properly 

and Poke Through may be evident even before posing the 

character. Some clothes come with morph dials that can be set to 

allow them to be fit to certain new characters (who might have 

been popular or common at the time the new clothes were 

created.) Sometimes adjustments to scale or the Morphing Tool 

can be used to fix the problem. Even then, posing can be 

problematic. Rather than fight to get the clothes to fit, I tend 

to ignore the Body INJ files and just use the original 

characters default body for which the clothes had been created. 

With the new face, I've got a new character. 

 

 B. A new face creates a new character. But is it the one 

that you expected? See the images below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 

This is one of the images of "Nana" that accompanied the web 

page describing this character to modify Victoria 4. I bought 

Nana and installed her. The following images are renders of Nana 

with my Poser Pro 11.1: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

I'm not sure that either one looks like the original, although 

the one on the right seems to me to be closer. The thing is, 

hair styles and makeup can make a big difference in how a 

character looks. 

 

The third process involves setting Properties Dials to value 

which morph various parts of a loaded character. Victoria 4.2 

comes with a DAZ's Victoria 4 > Morph Injections folder which 

contains individual morph INJ files (and folders with even more) 

that will fill empty Morphs|Shapes Properties Dials to allow you 

to alter various body parts, or, in some cases, allow you to 

give your base character certain characteristics of another 

character. For instance, you can give Victoria 4 the body of 

Girl 4. Similar folders can be found for Michael 4. With these 

dials loaded you can give your base character lots of new 

properties but it remains the base character unless you change 

the face. If you morph the face, you can have a "new" character. 

 

I haven't made much use of this process, but I have noticed 

something odd. Not odd is the fact that some of the 

Morphs|Shapes Properties Dials are preceded with "EMPTY" until 

you actually use the INJ files. But odd is that some are not 

always there. If I load Victoria 4 and look, I see headings for 

Male, Morphs++, Elite, The Girl 4, Aiko 4, Creature Creator, and 

Muscle. For convenience in testing the appearance of new hair, 

clothes, INJ characters, etc., I have some PZ3 files of Victoria 

  



available so that, for examples, all Hair assets are tested with 

the exact the same pose and size. When I load one of those PZ3 

files, the "The Girl 4" heading is missing from the list! I have 

not done exhaustive testing (and I'm not about to), but what I 

have found looking at a couple of normal image files is that PZ3 

files created with Poser 11 have the "The Girl 4" heading and 

those created with an earlier version (not sure how much 

earlier) do not have it, even if resaved with Poser 11. Also, 

loading the "The Girl 4" INJ file does not put the heading back. 

Just some things to keep in mind! 

 



 Overlapping INJ Files 

 

As I mentioned in the Hidden Maps section, adding a MAT file to 

an existing PZ3 file does not necessarily replace all the 

settings previously existing in the file, i.e., using a black 

MAT on red hair may leave some red hair settings in the PZ3 

file. Apparently, the same is true for INJ files. 

 

My model of the Adondi girl, Tahiti, wasn't quite what I wanted. 

Her hair style left her face looking rounder than I liked. 

Changing her hair to a new style helped, but I was still not 

satisfied. So I added the slimmer Bo Ann face. 

 

It still did not seem quite right. That's when I remembered the 

problem with the MAT files. I went back to Virginia 4.2, added 

the Bo Ann face, and got a much more pleasing result. 

 

So I experimented a little, adding a face to Victoria, then 

adding the Bo Ann face and comparing the results. In all cases, 

something of the first added face was left in the final face. 

Considering that I'd done a bit of experimenting with my first 

version of Tahiti, who knows how many faces were combined in 

that version? 

 

The conclusion is this: With INJ files, starting over from the 

beginning is probably better than adding an INJ file over 

previously loaded files - unless a combination of features 

provides an acceptable look. 

 

 



Parameter Settings 

 

Your joints can only bend or twist so far. However, some model 

makers do not prevent you from bending or twisting body parts 

way beyond what's normal. This is true, for instance, with 

Michael 4. The same is true for moveable parts of other figures 

or props.  

 

However, some modelers do set limits to prevent you from making 

"illegal" bends. The Parameter dials cannot be rolled or 

manually set to values greater than a predetermined value. This 

is usually to your advantage - you won't accidentally open or 

close a door beyond its natural stopping point. 

 

Sometimes you may want to use a setting greater than the 

modeler's predetermined limit. In a picture that I was creating, 

I needed to bend a tortoise's legs and a frog's feet so that 

they could stand on their hind legs. The Parameters dials were 

set so that I couldn't do that. 

 

I don't know if what follows is true for all models, but I was 

able to change these parameter settings so that I could make my 

critters stand. To reset parameter limits, do the following: 

 

Click the ► at the right of the Parameters Dial > Settings... > 

Change the value to something greater than the current limit > 

OK 



 Parenting 

 

I. Attaching one Figure or Prop to Another 

 

After creating my Diana the Huntress statue I discovered the 

benefits of "Parenting." I'll use Diana in the explanation that 

follows. 

 

Each object brought into a scene (except for conforming clothes 

once they have been Conformed To) can be moved independently of 

all others. This is fine, but once a bow, for example, is placed 

in the hand of Diana the Huntress, it would have been nice to 

have it move with her when I wanted to set her onto her base. I 

had to move the base under her instead. 

 

Objects can be attached to other objects by the process of 

Parenting. Objects may be either or both Figures or Props 

(Theoretically! – See NOTE at the end of this section).  

 

Select an object in the scene (such as the bow), the "child." 

 

Go to the menu tabs at the top of the screen and select Object > 

Change Parent to open the Object Parent dialog. (You might want 

to open this list by clicking on the down-pointing triangle at 

the top left of the dialog box.) Scroll through the list and 

click on the item that you want to attach to (the "Parent"). I 

chose the Body of Victoria 4, but it might have been preferable 

in some instances to have chosen a more appropriate body part 

("left hand" to parent "bow," for instance) although since I did 

this after all posing was finished, it didn't seem to matter. 

 

A check box for "Inherit Bends of Parent" is located at the 

bottom of the window. I'm not sure if this is needed for all 

children, but it probably doesn't hurt to check it. Click OK. 

 

The "child" will now move with the "parent." It can even be 

moved elsewhere in the scene and will still move with the 

parent. 

 

The child can also be scaled with the parent. Note: Hair or 

clothes, even when Conformed To the figure, do not scale with 

the figure unless they are Parented to the figure. 

 

I want to report an odd experience that I had with Parenting 

(No, not with my kids.) I'd received an email from HiveWire 3D 

advertising a Venus fly trap. The image of the open traps 

reminded me of a painting by Botticelli of "The Birth of Venus." 

In his painting, a nude, adult Venus was standing on a scallop 

shell (the Shell gas station shell.) Why not have Venus standing 



on a Venus fly trap? When creating the scene In Poser Pro 11, I 

loaded three instances of an Exnem scallop shell to protect 

Venus' modesty (something not done in the original painting.) I 

moved each shell into the appropriate position, Parented each to 

Venus, and loaded a Girl 6 pose that resembled the modesty pose 

in the painting. One of the three shells immediately distorted 

into an unrecognizable smear. It returned to normal if I 

unloaded the pose, but, even after parenting the shell to 

various parts of Venus' body, or to other items in the scene, it 

smeared out when the pose was reloaded. One solution was to 

leave the shell unparented, then move it every time I moved 

Venus. The other solution was to load a fourth shell and delete 

the offending one. This worked. The new shell could be parented 

to Venus with no problem! No explanation. It just did. 

 

NOTE: I have had instances where a prop would not parent to 

another prop. I solved this by parenting both props to a small 

figure that I then hid in the scene. I cannot explain this 

problem. I could not duplicate while experimenting today. 

Perhaps I made some error when trying to parent the prop, or 

maybe Poser just doesn’t cooperate. An alternate solution to 

this “problem” is Grouping the objects. 

 

II. Attaching multiple components of a Figure or Prop to a 

Single Component, the new Parent 

 

I have bought a few Props which are not in Poser’s CR2 format. 

They come as OBJ, DAE, or FBX files which must be Imported then 

Saved to the appropriate Library. Unfortunately, some of these 

turn out to be collections of Props with no Parent, which means 

that there is no way to deal with the new Prop as a single 

object. For instance, I can’t select a boat’s hull to move the 

entire boat – the hull is moved and everything else stays 

behind. To solve this, each of the components can be Parented to 

the hull by the technique described in I. above. However, if the 

new Prop contains dozens of components, this is time consuming 

and tedious. It’s easier to use the Hierarchy Editor as follows: 

 

Click on the Windows drop-down menu 

 

Click on Hierarchy Editor 

 

Click on a Child component and Drag it to the desired Parent. 

(It might be best to choose the first item in the list to become 

the Parent.) Drop on the Parent 

 

Repeat for each component until all are Parented 

 

Exit the Hierarchy Editor and Save the Prop to the Library. 



 Poke Through/In 

 

Poke Through is the term to denote skin or something else poking 

through clothing, even when Conform to... has been applied. It 

often happens when the figure pose is changed. Several 

techniques can be tried to correct the problem. 

 

Poke In is what I call the hair penetrating the shoulders or 

back of a figure. 

 

 1. Invisible parts. Make the offending object invisible if 

it can't be seen anyhow. For instance of a leg shows through a 

dress or trousers, but is completely covered by the clothes, 

make it invisible. 

 

 2. Use the Community setting. I have no idea what the 

Community setting is for, but it worked with the Anjiru shirt 

and shorts on the Victoria 4 + Helena figure. The breasts and 

the bum showed through. Select the body part which is exposed, 

then open the Parameters tab > Injection Channels > Community = 

-1 and the skin disappeared. 

 

 3. Change Scale - 1. The skull of the Victoria 4 + Helena 

figure showed through the Shigi hair. Changing the Community 

setting had no effect. I selected the hair, but Parameter > 

Transform > Scale = 102% made the hair cover the skull. 

 

 4. Change Scale - 2. The selected parts of clothing can 

sometimes be scaled. For instance, the belt and top of the 

shorts the shirt I used with my Gina figure stuck through the 

bottom of her shirt. I made the "hips" of the shirt slightly 

larger and they covered the belt. 

 

 5. Paint Over. A paint program, such as Adobe Photoshop, 

can be used to paint over some poke through. I've used the Clone 

Stamp tool. The Healing Brush or the Color Replacement tools 

might also work in some instances. 

 

 6. The Morphing Tool. The Morphing Tool can be used to pull 

the surface of the clothing away from the item poking through. 

But be careful, or you may end up with a bump instead of just 

smoothing the surface. To use the Morphing Tool: 

  A. Select the clothing item 

  B. Click on the Morphing Tool (at the upper left, 3rd 

item in the bottom row) 

  C. Click on the desired action - Pull 

  D. If not already set, click on Surface after Relative 

To 



  E. Set the brush style (the spots), the Radius, and 

Magnitude of the brush. You can get an idea of the Radius needed 

by moving the array of colored dots/cursor over the area to be 

fixed. 

  F. Click and drag the brush spots over the area of 

poke through and watch the poke through slowly disappear. Be 

careful, sometimes it looks like nothing is happening until you 

release the mouse button. You may have to repeat this step 

several times if the area of poke through is very large. Just BE 

CAREFUL! 

  G. Exit when finished. 

 

 7. Poke In. The 2 "tails" on the Shigi hair penetrate the 

back of the "Victoria 4/Helena" model in the art22 pose from 

DAZ's Victoria 4 Life Poses. Selecting the hair, then Morphs > 

Tails_R_Back = 0.5 and Tails_L_Back = 0.4 brought the hair up 

and out of the back. 

 

 8. Make sure that the clothes that you are trying to use 

are made for the character that you have created. I was trying 

to create one of the characters from my "Silver Threads" novel. 

I loaded Michael 4 and modified him by adding the Beck head, 

body, and MAT files. When I added Shorts upgrade, TShirt 

Upgrade, Socks Upgrade, and Runners Upgrade (shoes) from M4 

Clothing: M4 Basic Wear, I had poke through with the shirt and 

shorts, even after doing a Conform to Michael 4. I was able to 

get rid of most of the poke through by changing some scales and 

morphs for the clothes, but was afraid that I'd have to start 

all over again when I posed my new character. Then I remembered 

that when I added the Beck Body, the shape of the model changed 

slightly. I removed the clothes and the Beck Body. When I 

reloaded the clothes and conformed them to Michael, there was no 

poke through. The clothes would not conform to the slightly more 

muscular Beck version of Michael 4. So, unless you can find 

clothes specific to a modified body, you may be able to avoid as 

much poke through by not using INJ files or other morphs that 

enlarge parts of the body of your character. 

 

 



 

Portraits 

 

See also Eyes > Point At  

 

The easiest thing to do for a portrait is to load and pose a 

character in front of an imported 2-dimensional background. Once 

the background is imported, manipulating the character is 

simple. And I do have a lot of purchased backgrounds or 

backgrounds created from my own photos. The problem arises when 

I don’t have a suitable background or I prefer to use one of my 

3D scenes. 

 

I’ve done several portraits which involve a closeup view of a 

character in front of a more distant 3D scene, such as a pirate 

in front of ship in a port town. The problem with this is that 

the background scene needs to be quite a ways away from the 

camera while the subject needs to be quite close. Since it is 

often easier to move the character than the background scene, I 

usually pose the camera in front of the background scene, load 

the character, then go through a lot of laborious x, y, and z 

translations to get the character in the proper place near the 

camera. It finally dawned on me that there is a simpler way to 

do this. 

 

Load and pose the 3D scene as I want it to appear in the 

portrait. Render the scene and Export the image. Save the image 

in the Saved Backgrounds folder in my Backgrounds folder. Then 

import this image whenever I want to use it behind my character, 

just like I would do with any other Background image. 

 

 

 



Post-Production 

 

Post-Production is doing something to your image after 

rendering. You might wonder why this is necessary, but post-

production can often be used to correct defects in your image. 

 

The major reason that I do post-production is because the 

figures and props in Poser are not real objects. You cannot 

place two real objects in the same place: They can't overlap. 

However, 3D graphics are just a bunch of numbers used to create 

what looks like a 3D scene on your 2-dimensional screen: Two or 

more objects can overlap. 

 

For example, place a hat on someone's head and their hair is apt 

to stick out through the hat's crown. I discussed how I take 

care of this problem in the Hats and Hair section of Hair. 

Similar problems are discussed in Poke Through/In.  

 

I had a character wearing a kilt who was sitting on a log. 

Because the kilt was not a real object, nor was the log, the log 

did not push the kilt up under the character. It penetrated the 

kilt. A portion of the kilt could be seen sticking out through 

the log. Photoshop's Clone Stamp Tool allowed me to cover the 

exposed kilt with another portion of the log. 

 

Image editing programs like Photoshop have a number of tools 

that are handy in correcting problems caused by Poser's 

limitations. 

 

 



 Printing Images 

 

To create an image for printing on 8.5x11 inch paper, change the 

default Render Dimensions of 1401x831 pixels to 1401x1082 pixels 

for Landscape images. Reverse these dimensions for Portrait 

imges. 

 

I normally reset the Render Dimensions to 1920x1080 pixels to 

create an image for use on my Windows Desktop. I crop this to an 

11x14 or 110x85 (11x8.5) aspect ratio, depending on the size of 

the printer paper. However, although my Age of Aquariums image 

could easily be reset to 1920x1080, cropping to the 110x85 

aspect removed too much of the image to look right. So I reset 

the Render Dimensions as described above to give a picture that 

fit the paper. 

 



 Props from Scenes 

 

Some Scenes come with props that are not available separately in 

the Library. To make them available for use in other Poser 

images, these can be saved to the Library as individual props as 

follows: 

 

 1. Select (or create, if needed) a Library Folder to save 

to. 

 

 2. Select the prop to save. 

 

 3. Click the Add to Library button [+]. 

 

 4. Fill in the Set Name. 

 

 5. Click the Select Subset button if the prop could be made 

of several pieces that you want to save together (such as a bed 

+ mattress + sheet + blanket + pillows) 

 

 6. Check all boxes of all the items to be saved with the 

selected prop 

 

 7. Click OK and the prop appears in the Library folder. 

 

 8. If you find that the prop cannot be rotated, scaled, or 

other Properties can't be changed, look in the Object drop down 

menu and uncheck Lock Object. The prop can now be resaved - but 

make sure to repeat the Select Subset and following steps. 

 



Props, Smart - UnSmarting 

 

A Smart Prop moves directly the position in a scene where it 

belongs. For instance, a sword moves directly to the hand (you 

probably can choose left or right) when loaded from the Library. 

A desk moves to its correct position in a room when loaded. A 

lamp moves to its position on the desk when loaded (or it moves 

to that position - suspended in midair - and waits for you to 

load the desk. Smart Props are great timesavers (and they avoid 

the anxiety and tedium placing a sword in a hand.) 

 

But what if you want to use that table in a completely different 

scene. It may be nowhere near where you want it. It may not even 

be seen at its current location. You cannot simply set x-, y-, 

and z tran to 0.0.0 - it's already there according to the 

Transform dials. But, obviously, it isn't. It thinks its current 

position is the Origin.  

 

You can manually move the desk to the Origin, but the Transform 

dials will simply tell you where it is relative to its original 

position. In fact, you can manually move the desk to any 

position you want and you can still use the Transform dials for 

fine adjustments. 

 

I'd like to have some way to "UnSmart" a prop - load it, UnSmart 

it, and watch it appear at the Origin. I have not found any such 

function. However, I have found a work-around: 

 
 1. Select the Main Camera 

 

 2. Load the Morphing Primitives Ball. It loads with its 

center at the Origin. 

 

 3. Load the prop to be UnSmarted and manually move it to the 

Origin as indicated by the Ball. If the item cannot be seen in 

the scene, use the Top Camera to make it visible, Then manually 

move it in the X and Z directions so that it centers on the 

Ball. Switch back to the Main Camera and use the x-, y-, and 

zTran dials to fine tune the placement of the item. 

 

 4. Change Parent to Universe (even if already Parented to 

Universe) and check the box at the bottom for Inherit Bends of 

Parent. The Transform dials will reset to 0.0.0. 

 

 5. Delete the Ball 

 

 6. Select the item and Save it to the proper Library 

folder, as described in Props from Scenes.  



I’d completely forgotten that I had the above technique and 

found an alternative technique. It isn’t quite as good because 

it keeps the Ball as part of the prop, but here it is (in case I 

need it someday): 

 

 1. Select the Main Camera 

 

 2. Load the Morphing Primitives Ball. It loads with its 

center at the Origin. 

 

 3. Select the desired prop, then Object > Add Constraint > 

Ball > OK. The prop moves to the Ball and its coordinates become 

that of the Ball. 

 

 4. Rename the Ball to something convenient and make it 

invisible. 

 

 5. Select the Ball (with its new name) and move it whenever 

you want to move the original prop. 

 

 6. Save the Ball/prop combo to the Library. 



 PZ3 Files That Come With Models 

 

Some Scene models come with "Preloads" in their Library so that 

it is not necessary to load and pose all the scene's Figures and 

Props. Some, however, do not, but they may come with a PZ3 file 

that is separate from the Runtime folder's files. It can 

probably be found along with the ReadMe files, etc. Place this 

PZ3 file into a convenient subfolder (I place mine into a 

\Working Files subfolder which I name with the title of the 

model.) Now this "Preload" file can be accessed by Poser's File 

> Open menu, just like other PZ3 scene files that have been 

saved. 

 

An alternative method for loading the Preload is to save it to 

the Library, in the same way that I described in the Props from 

Scenes instructions above: Load the PZ3 file, create a Library 

folder to save to, the follow the Props from Scenes steps 3 

through 7. 

 

 



 

Render Artifacts/Blothes 

 

Rendering sometimes results in triangle or parallogram blotches 

on some surfaces. I cannot find that I’ve written down solutions 

to these artifacts anywhere, so I’m doing it now for those that 

I can find: 

 

Canyon 2: Hillsides showed triangular or rectangular blotches. 

1) Turn OFF Shadows, or 2) use the Daylight D that comes with 

Canyon 2 

 

Coalville Tenement: The Sheets on the laundry lines showed 

triangular blotches. For each Sheet, set Morphs > Waves = 0.0 

 

Jungle Village: Triangular or rectangular blotches were on the 

mountain sides. The problem was caused by overlapping of 

geometries that made up some of the ground. Truform fixed this. 

Turning off Shadows also helped. 

 

 



Render Dimensions 

 

Setting the default render dimensions to 1401x788. 

 

On my Boxx laptop computer, the default size and render 

dimensions for the Preview Window are 1401x831. In the past, I 

have done my work and did test renders with those dimensions. 

When I get to my final scene I usually want to render it so that 

I can use it as my Desktop image. The screen on my computer is 

1920x1080 pixels, so I change the Render Dimensions to give an 

image that fits my screen. 

 

However, setting Render Dimensions to 1920x1080 gives an image 

with a different aspect ratio than the default one that my scene 

was created with. As a result, there can be some cropping of my 

final image. In some cases, this is irrelevant. However, 

sometimes things are cropped out that I would rather keep in the 

picture. My normal solution is to either move the camera back 

from the scene or decrease the camera's focal length slightly to 

get the missing items back in the scene. 

 

An obvious solution to this problem would be to set the Render 

Dimensions to 1920x1080 when I begin work. The Preview Window 

does not become 1920x1080, but it is reset to show an area of 

the same aspect ratio. The window itself does not resize, but 

instead a couple of darker regions - one at the top and one at 

the bottom - can be seen with parts of the scene that will not 

render. The "normal" region would allow me to work on my scene 

without having to worry about resizing when I get my final 

scene. I say "would allow" because I don't do this. Doing the 

obvious means that all test renders are 1920x1080 in size - so 

they take longer to render and the entire scene cannot be seen 

in the Preview Window when finished. 

 

What I have done is to set the Render Dimensions to 1401x788 

with a blank screen, then click Set Preferred Scene in Edit > 

General Preferences. Now every time I start a new image, the 

Preview Window starts with these dimensions, which gives the 

same appearance and aspect ratio as if I had set dimensions to 

1920x1080, except that test renders fit in the Preview Window, 

take no longer than normal, and the final scene can be reset to 

1920x1080 with no fiddling with the final scene needed. 

 

My Desktop has my icons lined up along the outer edges of the 

window, which blocks off some things in my Desktop image. In 

most cases, this doesn't really matter. But I sometimes have 

something of interest near the bottom of the image which may be 

obscured by some of these icons. If I make sure that nothing of 



interest is nearer than 1 5/8-inches from the bottom of Poser's 

gray window (not the Preview Window), this avoids the problem. 

 

 



 

Render Engines 

 

The Default/Legacy render engine for Poser is Firefly. Recent 

versions of Poser also have the Superfly render engine. I 

presume the Superfly engine is supposed to be better than 

Firefly. Textures designed for Firefly may or may not be 

compatible with Superfly. Fortunately, many are. But Superfly 

textures are likely not compatible with Firefly. 

 

What’s a body to do? I’m not sure. 

 

Since the introduction of Superfly, many asset creators have 

been providing separate figures and props for each (just as some 

have for SSS and non-SSS skin textures.) But not all do. The ad 

for the asset of interest should tell you if it renders in 

Firefly, Superfly, or both. But not all do. I just purchased a 

character. After a long list of poses I found the statement “All 

materials use Superfly shaders. The model will not render 

correctly using Firefly.” Unfortunately, I didn’t find this 

statement until a couple days after buying and paying for the 

character when I was trying to figure out why it wouldn’t render 

properly (in Firefly, of course.) Documentation for the 

character didn’t mention this restriction. 

 

The Poser 13 version of Superfly comes with a bunch of “Presets” 

to set the engine’s various options. It may be necessary to 

experiment with these to get Superfly to produce acceptable 

images. After some experimentation with Presets and the above-

mentioned character, I gave up, clicked “Restore Defaults,” and 

tried one more time. This time I got an acceptable image 

containing the new character and Michael 4. But this “default” 

can’t be the same as the default present when I initially loaded 

Poser 13 because those options gave a rather “flat” render of 

Michael. So I saved this new “default” as “New Superfly Preset” 

to try in the future. Unfortunately, although it gave an 

acceptable render of Michael 4, trial Victoria 4 characters 

created with Firefly Pose Mats were “over-exposed.” 

 

What’s a body to do? I’m still not sure. 

 

 

 



 

 Scaling 

 

All figures are created some specific size. However, there may 

be times when a figure might be better some other size: Two 

figures are in the same scene and one is taller than the other; 

you want to create something toy-like. 

 

To change the size, select the object, then Parameters > Scale > 

Scale (x,y,z) and change from 100%. If only some of the 

dimensions need to be changed (lengthening a cube) then just 

scale x, y, or z to the proper percent. 

 

Percents larger than 100% increase the size; smaller percents 

reduce the size. 

 

 

 

 

 



Scripts 

 

 Python is a part of Poser that allows you to run small 

programs called "scripts" to automate certain tasks or to do 

things that Poser can't. They are found in the "Scripts" tab at 

the top of the screen. 

 

 On my computer, the folders that contain these scripts are 

found in C:\Program Files\Poser Software\Poser 

##\Runtime\Python\ poserScripts\ScriptsMenu  (where ## is 11 or 

12). If you purchase or download a script you may need to 

manually install its folder into this location. 

 

 On my old Boxx laptop they were found in C:\Program 

Files\Smith Micro\Poser 11\Runtime\Python\poserScripts\ 

ScriptsMenu 

 

 Poser comes with an assortment of scripts, most of which I 

have never used. Back with an earlier Poser version I obtained 

the DSON Importer which was used to allow Poser users to load 

and render assets intended for DAZ Studio. This no longer plays 

well with Poser Pro 11.3 

 

 Scatter Tool is a script by ken1171 which I purchased from 

HiveWire 3D. The purpose of this tool is to allow you to scatter 

figures or props randomly over the surface of some irregularly 

shaped "ground" prop. I haven't done any renders using this yet 

(as of 2020 06 30), but have played with it enough to see that 

it could be useful - with certain reservations. Not every figure 

or prop can be placed onto the surface of the "ground". Ken1171 

suggested changing some values for the misbehaving item in 

Poser's Joint Editor. This didn't work for my randomly selected 

test animal, Lyne's Sheep, which scattered but "sank" into the 

surface. It’s a mystery. The tool has a button to allow you to 

remove the items scattered--if done before you exit the tool. 

The HiveWire Horse would scatter over the surface but could not 

be removed by this button. It's a mystery. This button does not 

function if you have exited and restarted the tool - unless you 

select the item scattered previously, the right-click the 

button. But this does not work either. It's a mystery. Still, 

for those items that are constructed in a way that works with 

the tool, it looks useful. Apparently, ken1171 is working on 

some upgrades to enhance what the tool can do. 

 

 Snow Machine is a script by Snarlygribbly that places a 

"layer" of snow over things in your scene. Version 2.2 was 

supposed to accompany "Movie Sets: City Block 01" by Dreamland 



Models. However, I could not find it in the Scripts menu. I did 

eventually find it by following a folder path to its location on 

my hard drive. I installed its "Wacros" folder in the location 

above and it works fine. There was no documentation for the 

script, but the options are pretty self-explanatory. I did 

download a ZIP file from http://www.snarlygribbly.org/poser/ 

that contains Version 2.3 and a PDF file of documentation. The 

PDF has some cautions that are worth remembering. The script 

does not add a Snow Figure or Prop to the scene. It modifies the 

surface textures so that they appear to have a layer of snow on 

them. It ignores things that have their Visible property 

unchecked, in case you don't want somebody or something covered 

in snow. HOWEVER, if the scene is very complex, it can take 

"forever" (i.e., a long time - overnight?) to render. Below are  

 

 

 

 

 

 

 

 

 

 

 

two images of my Snopo Hunting picture. I deleted all the trees 

that could not be seen in the Preview in hopes of speeding up 

the render. It did speed up, some. The Screen Capture is an 

image of the Preview pane. I started the render about 7:45 PM 

and ended it about 6:30 AM the next morning. Still a long way to 

go. 

 

 

 

 

 

 
Screen Capture 

 
Render after 11 hours 



 Skin Tones, Gamma, and Diffuse 

 

 I've noticed that the skin tones of some characters seem to 

be somewhat cadaverous. One reason is that the character's MATs 

have a blue-green Diffuse color. Sometimes just changing the 

Diffuse to White fixes the problem. I've found some other 

Diffuse colors that can also be used: 

 

Human Caucasian Skin Tone: RGB = 226:208:197 

(modification of JessieFBM) 

 

Human Hispanic Skin Tone: RGB = 204:166:141 (based on 

Diego) 

 

 Here are also some Diffuse colors for the Adondi: 

 

  Adondi Skin Tone: RGB = 84:170:255 

 

  Adondi Nails: Blue from R1 C6. RGB = 0:128:255 

 

 Another factor that affects skin tone is Gamma. The default 

gamma setting in Render Settings is On (checked) and 2.20. For 

Caucasian skin tones, turning Gamma Off before rendering gives a 

darker, redder tone. 

 

 Experimenting with Gamma On vs. Off and with different 

Diffuse colors may provide more pleasing skin tones. 

 

 Following are some renders of Victoria 4.2 or Victoria 4.2 

plus some character INJ where I have changed the Gamma and or 

Diffuse settings: 

 



 Victoria 4.2 with her default blue-green Diffuse: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Victoria 4.2 with Diffuse set to White: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gamma = Off Gamma = 2.20 

Gamma = Off Gamma = 2.20 

  

  



 Danielle INJ from Renderosity. Diffuse = blue-green 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Danielle INj with Diffuse = White 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gamma = Off Gamma = 2.20 

Gamma = Off Gamma 2.20 

  

  



 Anahi INJ from DAZ 3D. SSS MAT. Diffuse = Black 

 Note: this is a brown skin tone 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Anahi INJ. SSS MAT. Diffuse = White 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gamma = Off Gamma = 2.20 

Gamma = Off Gamma = 2.20. Brown is gone! 

  

  



 Suzanne INJ from Renderosity. SSS MAT. Diffuse = Black 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gamma = Off Gamma = 2.20 

  



Special Colors and Textures 

 

Sometimes when creating a scene I need colors or textures that 

are not found in the assets being used. When I create a special 

color or find a useful texture map, I may write the pertinent 

info here. NOTE: When a location is specified, this is the path 

on my computer. 

 

 1. Adondi: 

  Adondi Skin Tone: RGB = 84:170:255 

  Adondi Nails: Blue from R1 C6. RGB = 0:128:255 

 

 2. Human Caucasian Skin Tone: RGB = 226:208:197 

(modification of JessieFBM). NOTE: See the discussion in Skin 

Tones, Gamma,  and Diffuse. 

 

 3. Human Hispanic Skin Tone: RGB = 204:166:141 (based on 

Diego) 

 

 4. Purple: RGB = 150:120:255. Use for clothes in my 

“Purple” picture. 

 

 5. Sand Color and Texture 

  A. Materials > Poser Pro 11 Contents > Basic Materials 

> Stones: Sandy Ground. This produces a very gray sand. Setting 

the Diffuse RGB in the Materials Color Picker to the following 

gives some better colors: 174:143:81(dark brown), 213:215:132 

(light brown), 247:237:183 (light brown) 

  B. Libraries > Scenes > Runtime > Textures > 2nd World 

> Tropical Island, The Beach: 2nd_W_TIB_Sand.jpg 

 

 

 



 

Speckles in Close-ups 

 

I have noticed that close-ups of the V4 Danielle figure that I 

use to create renders for my Clothes or Hair Catalog entries 

tend to show dark “speckles” around her eyes. I found out today 

that instead of using the default skin MAT, the speckles do not 

form if I use the SSS (Subsurface Scattering) MAT. 

 

 



 Spheres for Planets, Etc. 

 

I found some texture maps among the files from my old TrueSpace 

program. One was for the Earth, another for the Moon. I was 

curious to see what would happen if I tried to use them with 

Poser. So I loaded a spherical primitive from Poser Pro 2012 > 

Props > Primitives, went to Materials, and changed the Ambient 

map to one of these new textures. Both worked fine. They covered 

the sphere seamlessly. 

 

Poser has three spheres: Ball Hi-Res, Ball, and GeoSphere in 

Primitives and another Ball in Morphing Primitives. Each act a 

bit differently. 

 

Ball Hi-Res is loaded with xRot = -90 to get its polar axis to 

coincide with the scene's x-axis (as seen in Texture Shaded 

mode) and the sphere's south pole is setting at the scene's 

origin. The maps load properly with north poles up. The sphere 

rotates about its center, not scene center. xRot and zRot work 

normally, rotating the sphere around the corresponding axis. 

However, yRot rotates the sphere around its z-axis. If xRot is 

set to 0, yRot works as it should but the sphere is rolled over 

on its side. 

 

Ball (from Primitives) is loaded with all Rotation dials set to 

0. Its polar axis coincides with the y-axis of the scene and the 

maps load as expected. The Rotation dials rotate the ball as 

expected, although the rotation is around the ball's south pole 

(which allows yRot to rotate it around its polar axis.) 

 

GeoSphere loads but has does not show the polar coordinates of 

the other spheres. Its faces are all squares. It sets on the 

scene origin like ball, but rotates about its own axes like Ball 

Hi-Res. The Earth map is not wrapped around the sphere properly. 

or seamlessly. I wouldn't recommend this for planetary spheres. 

 

Ball (from Morphing Primitives) loads with Rotation dials set to 

0. Its polar axis coincides with the y-axis of the scene and it 

is centered at the scene origin. Rotation dials function as 

expected, rotating the sphere around its own center. Maps load 

seamlessly. Decreasing yScale from 100% can produce a Jupiter-

like spheroid. A variety of morphs that are part of the 

Parameters can produce a variety of weird shapes 

 



 Subdivision 

 

I purchased Zora Hair from Renderosity and found that the 

Documentation (and even an icon in the Library) said to 

"Subdivide Hair in Final Render." I had no idea what this was 

about, and eventually found a detailed section in the Poser Pro 

11 Manual which talked about Subdivision (Chapter 36: Skinning 

and Subdivision Surfaces). However, searching for "poser 

subdivide" with Google gave me a page 

(https://www.youtube.com/watch?v=DP5HRdzMMCo) with a video 

tutorial which I could understand more easily. 

 

Subdivision increases the number of vertices to provide a model 

with more polygons - which means that it should look better. 

However each increase in the level of subdivision (1 > 2 > 3 

etc.) increase the total number of polygons by 4 (4 > 16 > 64 > 

256 x original number, etc.), so anything over a level of 2 may 

be unreasonable as far as system resources go when render time 

comes. 

 

NOTE: I tried subdivision levels of 1 and 2 for the Zora Hair 

and could not see a significant difference, so I'm not sure why 

I should bother with this. However, in case I ever find a real 

use for Subdivision, the instructions boil down to these: 

 

 1. Select the body part for subdivision (such as Hair) 

 

 2. Figure drop down menu > Skinning Method > Poser Unimesh. 

 

 3. Go to the selected item's Properties tab and set the 

Subdivision Levels - Render to the desired level 

 

https://www.youtube.com/watch?v=DP5HRdzMMCo


Subsurface Scattering (SSS) 

 

In order to make skin look more realistic, some characters come 

with a property called "Subsurface Scatting," or "SSS." When 

rendered, the regions with SSS are rendered first (making the 

render look a bit weird) and then the entire scene is rendered. 

 

I am not going into Subsurface Scatting itself here, but want to 

say something about attempts to change the skin texture of 

characters with SSS. For instance, I might want to give a 

character an unusual skin texture in order to create an alien. 

 

If you are using a texture from the Poser Library, you only need 

to select the character, then select the Library Texture. A 

window will open that asks you to select the part of the 

character (the face, the hands, the toenails, etc.) to apply the 

texture to. Work your way through all desired parts of your 

alien and you are ready to render. 

 

However, not all textures may end up in the Library. Some folks 

sell JPG files of textures that are stored in folders outside of 

Poser. To apply these textures to a non-SSS item, select the 

figure or prop. Go to the Simple Window of the Materials Room, 

select the first part of your figure or prop, click on the 

Diffuse Map, click the Browse button and browse your way to the 

desired texture. Double Click on it, click on OK and repeat the 

process for each part of your item to have the new texture. 

 

If you have an SSS character, you go through the process 

described in the previous paragraph, but when you click OK, it 

may look like nothing has happened or the applied texture does 

not look as expected. Don't panic. Click the Add Skin Subsurface 

Scatting button in the column of gray buttons to the right of 

the Simple window. The Material Preview at the bottom of the 

window takes on the texture. Move your cursor over the Preview 

Window at the far left and the texture will appear on your 

character. Repeat the process for each part of your item to have 

the new texture. 

 

NOTE: This muddling around can be avoided by first saving the 

exterior texture(s) to the Library, as described here. 



 TerraDome 2 

 

TerraDome 2 comes with a TerraDome UserGuide PDF file. However, 

it contains some unnecessary procedures and is not always clear 

enough to me. Following is information from the UserGuide or 

which I have found by testing which I feel that I can use.  

 

TerraDome 2 is a system for creating landscapes. It comes with 

six Figures and two Lights: 

 

 1. AZone is a circular region which is the foreground. 

 

 2. BZoneLg is a region which fits around the "northern" 

half of the AZone and which serves as a background. 

 

 3. The Skydome is for the sky color and clouds. 

 

 4. The Water Plane is (surprise, surprise) for water. 

 

 5. The Matte figure is for "background painted, photo, or 

rendered elements" according to the TerraDome Userguide. 

 

 6. The Parametric figure is for "Atmospheric/Cloud Effects" 

according to the TerraDome Userguide. 

 

 7. The Sun provides a sunlight illumination and can be 

moved with a Parameters Dial to simulate different times of day. 

 

 8. The IBL (Image Based Light) can be manually loaded, but 

if loaded after the Sun, it deletes the Sun light. In fact, if 

either of these are manually loaded after the other it deletes 

the first. The Sun should be loaded, then when a Material from 

the SkyDome Sets is loaded, the IBL is also loaded without a 

problem. 

 

The Figures Library contains a folder (Poser8Scenes) with eight 

ready-to-render scenes. These eight scenes are repeated in the 

Scenes Library. 

 

The basic procedure for using TerraDome 2 is as follows: 

 

 0. If you have not already unchecked Visible in the 

Ground's  Properties, do so now. For an explanation, see here 

 

 1. Load the Sun from the Lights Library. The TerraDome 

Userguide says to first delete all default lights. (Run Scripts 

> Utility > deleteLights.) But this is not necessary because 

loading the Sun light deletes any existing lights. 

 



 2. Load TerraDome from the Figures Library. This loads 

AZone, BZoneLg, and SkyDome. (Each could be loaded separately if 

desired, for instance, to place a second BZoneLg to the south.) 

 

 3. Set Yon for the camera(s) to be used to 6000. Yon sets 

the distance beyond which nothing shows in the Preview Window. 

This setting should guarantee that the SkyDome can always be 

seen. 

 

 4. Load a Material for the SkyDome from the SkyDome Sets 

(or other third-party) folder. This also loads the corresponding 

IBL without deleting the Sun. 

 

 5. Load Morphs (from Pose) for AZone and BZoneLg from Base 

Morphs or SR1 folders. Multiple morphs can be loaded for each 

Zone if desired. Use the Parameters Dials to set the amount of 

each morph desired. 

 

 6. Load Materials from the Terrain folders for AZone and 

BZoneLg. 

 

 7. Load and pose other items, then do a render. 

 

If water is desired, load the Water Plane from the Figures 

Library. Position the Water Plane as desired with the yTran 

dial. Load a Material for the Water Plane. TerraDome has two 

types of water materials: 

 

 1. Fresnel Water materials are to be used with shallow 

water because they have some transparency. But I don't think 

they work as well as expected. The "shoreline" tends to be too 

distinct and water very near the shore renders oddly. I did set 

the Transparency in the Materials Room to about 80% and got a 

more natural looking shoreline. 

 

 2. Reflect Water is opaque and should be used when you 

don't need to see into the water. 

 

According to a post by Andrew and Terry of Mortem Vetus on the 

Runtime DNA TerraDome 2 Forum, the Matte and Parametric figures 

are for add-ons (which I don't have yet.) That didn't stop me 

from playing around with them: 

 

The TerraDome Userguide said the Matte figure was for 

"background painted, photo, or rendered elements." I tried 

loading a JPG image onto it and got a distorted image. If the 

Matte is moved beyond zTran = -136.8, it intersects with the 

background. This does not affect the result of a render, but it 



makes the preview weird. I'll have to wait until I get one of 

those third-party add-on to see how the Matte figure works. 

According to the TerraDome Userguide, the Parametric figure is 

for "Atmospheric/Cloud Effects." I loaded Michael 4 and moved 

him to about zTran = -711.2 so that he was partially behind, 

partially in front of the Parametric figure. I loaded one of the 

Atmosphere materials and did a render. This just gave an opaque 

gray surface with Michael embedded in it. Moving the Parametric 

farther away showed it to be half of a hemisphere. Again, I'll 

have to wait until I get one of those third-party add-on to see 

how the Parametric figure works. 

 

If atmospheric effects, like distance haze or dust are desired, 

TerraDome can do it - sort of. Here's one way: 

 

 1. Get the rest of the TerraDome components set up as 

desired. 

 

 2. Minimize the Library Window. 

 

 3. Open the Materials Room to the Advanced Window. 

 

 4. Select Atmosphere from the first drop down menu. 

 

 5. Restore the Library Window. 

 

 6. In Materials, select the desired Atmosphere effect. 

 

 7. If the image does not look satisfactory when rendered, 

go back to the Advanced Materials room and adjust the DepthCue-

Start Dist and DepthCure-End Dist values. You can use these 

values to place the atmospheric effect where you want it. The 

closer the two numbers are to each other the denser the effect. 

Changing these values can be like setting a filter between 

landscape features, so that, for instance, a distant BZone 

mountain looks hazy but nearby AZone ones do not. And, as I 

said, decreasing the difference between the two numbers can make 

the mountain seem nearer or father by controlling the amount of 

haze effect. 

 

Unfortunately, when trying to make mountains look distant with 

the above procedure, the haze also obscures the SkyDome. The 

BZoneLg mountains can be made to look more distant by going to 

the Materials Room and changing the Ambient Color to a gray 

(such as R2C3 of the Custom Colors. The RGB = 95:95:95 for this 

gray. Changing this to 95:95:105 gives a bit more blue to the 

mountains. 

 



Distances: To find the distance or location of some feature in a 

TerraDome (or any) scene, I took Poser's Hi-Res Ball primitive, 

scaled it to 500% (to make it big enough to see from quite a 

distance) and colored it red. Moving the ball with its x, y 

and/or zTrans Parameters will show where some item is located. 

If you want to look with the Top Camera, turn off the visibility 

of the SkyDome (then turn it back on when done). Using the Red 

Ball, I found that the AZone has a radius of about 345 feet, the 

far side of the C-shaped BZoneLg is 680 feet from the center of 

the AZone, and so it is 335 feet across it. The SkyDome is about 

730 feet from the center of the AZone. (Which may mean that 

setting a camera's Yon to 6000 (TerraDome's recommended setting) 

may be a bit of overkill.) 

 

Grass: I have two Material collections to produce grass: Terrain 

- Grassland and Terrain - Moorland. The Grassland Materials just 

seem to produce brown or green textures that do not look very 

grassy to me, especially in scenes where I want larger grass. 

The Moorland Materials are taller and range from sparse to 

fairly luxuriant. According to Mortem Vetus' TerraNova 1 User 

Manual, "Different materials will give you different grass 

lengths, and densities. Some are quite thick, while others are 

sparse and patchy." I like Moorland-11 for a nice field of grass 

with the Circle of Hills AZone morph. Unfortunately, the 

Moorland grasses are all brown. This can be corrected by 

changing the Diffuse Color to green (such as Row 2 Column 3). 

The length of the grass can be increased by increasing the value 

of Bump from its default value. 

 

 



 

Transparency 
 

 

Page 360 of Poser 11 Manual:  

 

The Transparency, Edge, and Falloff dials work together to 

determine how an object’s transparency behaves. 

 

The Transparency dial affects the transparency of the part of 

the object facing the camera, particularly toward the center of 

the object. Higher Transparency values yield greater 

transparency. 

 

The Edge dial affects the transparency of the object’s edges 

specifically. A high Edge value makes the object very 

transparent on its edges. For most renderings, you’ll want to 

use a Transparency value that is higher than the Edge value. 

 

The Falloff dial determines the rate at which the transparency 

becomes more opaque as you approach the edges of an object. For 

a real world example, look at a transparent object such as a 

drinking glass. The edges of the glass are less transparent  

than the rest of the surface. This is where the transparency of 

the glass “falls off”. In Poser, you can vary this falloff 

behavior. A smaller value renders a sharper edge 
 
To use transparency to make an object invisible (if unchecking 

Visible in Properties does not work), set Transparency = 1.0, 

Transparency_Edge = 1.0, Transparency_Falloff = 0.0 

 

 



 

WinZip Problem 
 

WinZip is installed as the default program for unzipping .ZIP 

files. However, I have had a couple of occasions when double-

clicking on a ZIP file or right-click > Open With > WinZip files 

to unzip a file. I have found that right-click > Extract All 

will unzip the file. 

 

Zombie Text  
 

I don’t have an alpha-numeric set for Poser that I like to use 

with Zombie pictures, I create and render a Zombie picture. Then 

load it into Photoshop and add the text as follows: 

 

1. Select Text Tool 

2. Set Font > Baveuse, Desired pts, Text Color = Red 

3. Type the Text 

4. Click on Triangle in Circle at top right of Layers window 

5. Blending Options 

6. In Layer Style > Styles > Click on Zombie icon (mouse over 

 icons to see icon’s label > OK 

7. Select Move Tool > Move Text with Arrow Keys 

8. Flatten Image 

9. Save Image 

 

NOTE: The Blending options saved for Zombie Style are: Drop 

 Shadow, Bevel and Emboss > Contour, Texture 


